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Preface

About This Book

This preface describes:

» Apple software provided with Al1X

= what'sin this guide and who should use it

» the available print and on-screen documentation
» Specia terms used in this guide

What the Network Server software offers

The software described in this guide contains IBM’s Al X (version 41)
operating system for use on the Apple Network Server. In addition, Apple
Computer, Inc. has supplied AppleTalk networking services to work with
AlX, and two applications that use a Macintosh interface for handling UNIX
tasks. These are the Disk Management Utility and CommandShell (which is
used for terminal emulation).

Who should use this guide

This guide is for system administrators and users of AlX on the Network
Server. It is meant for those who are familiar with basic UNIX system

admi nistration techniques, but who are not familiar with AlXwindows, the
Common Desktop Environment™, InfoExplorer™, or the software that Apple
Computer, Inc. isincluding with AlX.




How to use this guide

This guide offers the basic information necessary to get up and running with
AIX on the Network Server. Detailed information on the use of the Al X
operating system and on system administration is available on screen. For a
discussion of the on-screen documentation, see “Documentation and On-
screen Information” next in this Preface

This guide begins with an introductory chapter (Chapter 1) that introduces
you to the basic hardware and software configurations, user interfaces, and
standard Al X system management tools.

Thisisfollowed by a chapter on installation (Chapter 2), which describes
installation of the AlX Base Operating System (BOS) and additional software
from Apple Computer (the Disk Management Utility and CommandShell).

Chapters 3 through 6 discuss system startup and shutdown, the use of the
AlXwindows graphical interface and the Common Desktop Environment, the
use of the InfoExplorer on-screen documentation system, and basic Al1X
gystem-administration tools.

Chapters 7 through 9 describe how to set up AppleTalk networking services,
how to manage file storage with the Disk Management Utility, and how to use
CommandShell for remote access

Chapter 10 offers assistance with error messages and troubleshooting.

Documentation and on-screen information

This guide is the only printed documentation that comes with Al1X and the
Apple software for the Network Server. However, it is assumed that you also
have Stting Up the Network Server available, which is incuded with the
Network Server.

Xii
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In addition, you can read or print IBM's AIX documentation using the
InfoExplorer hypertext retrieval system, which is described in detail in
Chapter 5. InfoExplorer makes available to you awide range of user and
system-administration documentation, including the Al X 41 Getting Sarted
guide, upon which this guide is based.

For quick-start instructions on consulting IBM documents with I nfoExplorer,
see “Using InfoExplorer to Learn InfoExplorer (Graphical Interface)” or
“Using InfoExplorer to Learn InfoExplorer (ASCII Interface),” in Chapter 5
of this guide

Usersinterested in learning more about AlX commands should consult the
information in the AlX \ersion 41 System User's Guide: Operating System and
Devices Users in a networking environment who are interested in learning
more about AIX communications commands should consult the Al X \erson
41 System User's Guide: Communications and Networks For information on
ordering documentation published by IBM, call 800-879-2755. From outside
the United States, call 919-850-7500.

Terminology used in this guide

This section explains the terminology used in this guide to refer to modifier
keys and to various mouse and keyboard operations

Modifier keys

If you are usng a keyboard that doesrit have an Alt key, use the Option key
wherever this guide refers to the Alt key.

Mouse buttons

Some users will use a three-button mouse and some a one-button mouse The
instructions in this guide are written for a three-button mouse, as are the IBM
documents that you can display with InfoExplorer (see “ Documentation and
On-Screen Information,” earlier in this chapter).
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If you are using a three-button mouse, the phrase the mouse button refers to
the first button (often called “the leftmost” button or “Mouse Button 1”) on
your three-button mouse When this guide asks you to perform a mouse
action, such as dicking to select an object, use the first button unless the
instructions say otherwise

If you are usng a one-button mouse, wherever this guide instructs you to
press the right mouse button, press the Right Arrow key on the keyboard. For
the equivalent of the middle button on a three-button mouse, press the L eft
Arrow key.

Basic mouse and keyboard operations

In this guide, some terms represent a series of actions that you perform with
the mouse, keyboard, or both. For example, the word enter indicates that you
type a character (or a series of characters), then press the Return key.

Hereisalist of standard terms for mouse and keyboard operations and the
meaning of each term.

Xiv
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Term

Action

Click

Double-click

Drag

Choose

Point

Select

Type

Press

Enter

Point to the object and then press and immediately release the
mouse button.

Point to the object and then press and release the mouse button twice
in quick succession without moving the pointer.

Point to an object on the screen, such as an icon that you want to
move. Press and hold down the mouse button while moving the mouse
until you have accomplished the desired task, such as moving the icon
to a new location, and then release the mouse button.

Activate a command in a menu by pointing to the menu title and
dragging (usually downward) through the menu until the command you
want is highlighted. Then release the mouse button.

Move the mouse to position the pointer over an object on the screen.

Designate where the next action will take place. To select an object
such as an icon, point to the object and click the mouse button once.
When selected, the object appears highlighted. To select text, drag
across the text until the entire range of text that you want to select is
highlighted.

Type a series of characters without pressing the Return key.

Press a single key or key combination without pressing the Return key
afterward, or point to an object and then press and hold down the
mouse button without moving the mouse.

Type a series of characters and then press the Return key.

This guide refers to the Return key, although your keyboard might label it the

Enter key.
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Introduction to the System

This chapter introduces you to the AIX operating system for use on the
Network Server. It covers the following topics:

hardware configuration

software configuration

user interfaces

AppleTalk and Mac OS applications

introduction to standard AlX system management tools




Introduction

For information on setting up the Network Server, consult Setting Up the
Network Server, which came with your Network Server, before you install AIX
or perform any other procedures discussed in this guide

This guide assumes that you are administering the system either from a
console, that is, amonitor and keyboard directly connected to the Network
Server, or from aremote Macintosh computer.

If you are planning to work on a console that is directly connected to the
Network Server, consult Stting Up the Network Server for hardware
specifications. The console allows you to use the Al X graphical interface—
AlXwindows or the Common Desktop Environment (for information, see
Chapter 4 of this guide). If you are administering the system from a remotely
connected Maci ntosh computer running Macintosh System 7 or later, you can
use the Disk Management Utility and CommandShell (see Chapters 8 and 9
of this guide).

You can also use aremotely connected X server, such as MacX on a
Macintosh computer.

2 Chapter 1/ Introduction to the System



The mouse

The mouse most commonly used with AIX has three buttons. If you are using
a one-button mouse, you can use the arrow keys on the keyboard for the
middle and right mouse buttons, as follows:

= |If you need to use the right mouse button, press the Right Arrow key.
= |f you need to use the middle mouse button, press the Left Arrow key.

@
i

@
I
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System software components

Your Network Server uses three basic types of software:
= application programs

= devicedrivers

= the AIX operating system

The following figure shows the relationship between the different software
programs and the hardware.

Computer system software relationship

Application programs

Device drivers

Operating system

Hardware platform

Application programs

Application programs allow you to perform specific user tasks, such as
running databases, file servers, or computer-aided design programs.
Device drivers

Device driversinteract directly with computer hardware elements, such as
printers and monitors, and shield the application programs from the hardware
specifics of computers.

4
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Operating system

The operating system is a collection of programs that controls the running of
the computer and organizes the resources of a computer system. These
resources are the hardware components of the system, such as keyboards,
printers, monitors, and disk drives The AlX operating system comes with
executable programs or utilities that maintain your files, send and receive
messages, provide miscellaneous information about your system, and so on.

An application program relies on the operating system to perform many
detailed tasks associated with the internal workings of the computer. The
operating system also accepts commands directly from you to manage files
and security.

Root-user processes and root permission

Root-user processes are programs that can be run only by a user with root
permission. A system administrator has root permission for all processes,
which allows him or her to

= read, writeto (that is, change), or execute any program or file
= call any system function
= perform certain subsystem-control operations

If you are not allowed to run a command or to read or change afile the
gystem displays a message saying you do not have the correct permissions or
you are not allowed to run that command. The system administrator may be
the only person who can log in as root on your system. However, the system
administrator can grant a user permission to use particular commands, giving
that user some control over processes.

Root-user processes and root permission 5



User interfaces

There are two types of user interfaces: the graphical user interfaces and the
command-line interface

Graphical user interfaces

When a user interface has graphic objects, such as windows and menus, it is
called agraphical user interface (GUI). This section describes the following
graphical user interfaces:

= AlXwindows
= The Common Desktop Environment (CDE)

AlXwindows

AlXwindows lets you move windows, resize them, and copy text from
window to window. It allows applications to run separately and appear
simultaneoudy in different windows on your monitor.

The aixterm terminal window, in the AIXwindows interface, emulates a
terminal. It contains a command-line prompt that allows you to run UNIX
commands. The AlXwindows interface is also used by many applications that
run on AlX. For a detailed description of the Al Xwindows interface, see
Chapter 4.

The Common Desktop Environment

The Common Desktop Environment (CDE) allows you to use icons to access
networked devices and awide variety of applications without having to be
aware of their locations, startup commands, or command-line options. It
allows you to exchange data across applications smply by dragging and
dropping objects.

6 Chapter 1/ Introduction to the System



The command-line interface

The command-line interface is a character-based interface It is aso known as
the shdl. The screen displays a system prompt, and the commands you type
from the keyboard appear next to the prompt.

The Disk Management Utility and CommandShell

In addition to AIX 41, the software used to run the Network Server also
includes the Disk Management Utility and CommandsShell, which were
created by Apple for use with AI1X on the Network Server. These applications
run on aremotely connected Macintosh computer. They connect to AIX
daemon processes to allow you to perform system administration tasks.

» The Disk Management Utility. This application allows you to manage all
aspects of disk storage It uses agraphical user interface that offers various
views of the disk storage structure as well as methods of adding to, deleting
from, and modifying the disk storage structure. For more information, see
Chapter 8, “Managing File Storage With the Disk Management Utility”

s CommandShel. This application is aterminal emulator that runs multiple
windows on your screen o that you can run different AIX applications or
processes simultaneoudy. For more information, see Chapter 9, “Remote
Access With CommandShell”

AppleTalk and AppleTalk services

You also have available to you AppleTalk and AppleTalk networking services,
created by Apple and engineered for use with AlX on the Network Server.
AppleTalk allows remotely connected Macintosh computers to access the
AlX server without using TCP/IP or other networking protocols. For more
information, see Chapters 7 and 8.

For information on standard network protocols, such as TCP/IR, see the
InfoExplorer article “Network Overview for System Management.”
InfoExplorer is described in Chapter 5

AppleTalk and AppleTalk services 7



Standard AIX system management tools

I'n addition to conventional command-line system administration, AlX
includes several system management tools and installation utilities, including
the Install Assistant, System Management | nterface Tool (SMIT), and Visual
System Manager (VSM).

The Installation Assistant application guides you through customization tasks.
The interface for Install Assstant provides step-by-step instructions for
completing each task. The application tells you why you would want to
perform certain tasks. If you are familiar with the tasks, you can ip the
instructions.

SMIT is amenu-based tool that constructs and executes commands from the
options you choose With SMIT you can

= install, update, and maintain software

= configure devices

= configure disk storage units in volume groups and logical volumes

= Make and extend file systems and paging space

= Mmanage users and groups

= configure networks and communication applications

= configure printers

» identify system problems

VSM provides a graphical interface that lets you manage your system by directly

manipulating icons. You can use toolsin VSM to perform many of the same
tasks asthe SMIT application. The VAM tool indudes the following applications:

= Device Manager, which displays system objects and dialog boxes that
represent your Systenis device configuration database This allows you to
manage objects such as graphic adapters, ports, buses, and memory cards.

= Print Manager, which allows you to perform basic SMIT tasks on printer
and print queues.

8
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= Storage Manager, which lets you manage physical volumes, volume groups,
logical volumes, and file systems through manipulation of icons

» Users & Groups Manager, which lets you add users with simple templates.
You can also set passwvords and the default interface for users.

For information on using VSM, see Chapter 6, “Us ng System
Administration Tools”

The software for the Network Server also provides Mac OS utilities that
provide a Macintosh interface for logical volume management (the Disk
Management Utility, see Chapter 8 of this guide) and terminal emulation
(CommandsShell, see Chapter 9 of this guide).

Where to go from here

If you have not yet installed Al X, proceed to Chapter 2.

Note: I you plan to use the Redundant Array of Independent Disks (RAID)
software as your disk controller, install RAID before installing AIX. If you
install RAID after AIX has been installed, you will have to reinstall AlX.
Back up your disks carefully following the backup instructions in Chapter 2.

If AIX has already been installed, proceed to Chapter 3
For information on the AlXwindows interface, see Chapter 4.
For information on I nfoExplorer, see Chapter 5

For information on administering the system, particularly if you need
assistance with AppleTalk, the Disk Management Utility, or CommandShell,
see Chapters 7 through 9

For troubleshooting assistance and information on error messages, see
Chapter 10.

Where to go from here 9






Installing AIX on Your Network Server

This chapter describes how to install the AIX Base Operating System (BOS).
This chapter also describes how to perform initial system configuration.

The topics covered in this chapter include:

getting ready for installation
installing the BOS

installing additional software such as extensions to the BOS provided by
Apple Computer

setting up your system after you have completed the BOS installation program
backing up your system

installing the BOS from a system backup

installing Mac OS utilities on aremote Mac OS client




Before you install

Before you begin the AlX installation process, do the following:

= Set up your hardware and connect any peripheral devices such as an
additional hard disk drive

= Locate your Installation CD.
= Obtain the Network Server key.

You must install the operating system on the local system (your
Network Server).

For information about setting up your hardware, see Stting Up the
Network Ser ver.

Installing the AIX Base Operating System
Follow these steps to install the Al1X Base Operating System.
1 Turnon your Network Server.
2 Insert the Installation CD into the drive.
3 Turn the front key to the left (service) position.

4 Restart your Network Server with the CD in the drive.

To restart your system, press the reset button.

el —

| Reset button

When your system starts, it will use the Installation CD as the boot disk.
A message appears asking you to define the system console

12 Chapter 2/ Installing AIX on Your Network Server



5 Press F1 and then Enter to use the local display as your console.

If you have a standard keyboard (without function keys), the top row of the
keypad serves as the function keys F1 through F4. If you have a standard
keyboard, press the Clear key on the keypad instead of F1

6 When prompted, select alanguage for installation instructions.
For English, type 1 and press Enter.
The following message appears on your screen.

Wl cone to the Base Operating System

Install ati on and Mai nt enance

Type the nunber of your choice and press Enter.

Choice is indicated by >>>.

>>> 1 Start install now with default settings
2 Change/ show installation settings and install
3 Start mai nt enance node for systemrecovery
88 HELP ?

99 PREVI QUS MENU

7 To begin installation, type 1 and press Enter.
To examine or modify installation settings, you can type 2 and press Enter.
The Installation and Settings screen appears.

Installing the AIX Base Operating System 13



Installation and Settings

Either type O and press Enter to install with current
settings, or type the nunber of the setting you want to
change and press Enter.

1. System Settings

Met hod of installation............. Preservati on
Di sk where you want to install........... hdi skO
2. Primary Language Environment Settings (after
install):
Cul tural Convention...... English (United States)
Language................. English (United States)
Keyboard................. English (United States)
Keyboard Type............ Def aul t
3. Install Trusted Conmputing Base............... No

>>> 0 Install AIX with current settings |isted above.
88 Help ?

99 Previous Menu

WARNI NG Base Operating Systeminstallation will destroy
or inpair recovery of some data on the destination disk
HDI SKO.

Use this dialog box to specify the following:
= theinstallation method

You can choose either the New and Complete Overwrite option or the
Preservation Install option. The New and Complete Overwrite option
erases all the information on your hard disk before installing the BOS The
Preservation Install option keeps the user data in the root volume group
when it installs the BOS

14 Chapter 2/ Installing AIX on Your Network Server



= the destination disk
» the language environment
» the Trusted Computing Base (TCB) setting

The Trusted Computing Base tries to ensure that the programs you run are
trusted programs. If you want to change the TCB setting, do so during
installation. This setting cannot be changed later.

8 When you have selected the appropriate settings, type O and press Enter to begin
the installation.

The Installing Base Operating System dialog box appears, which shows you
the progress of the installation and informs you when the installation is
complete

The installation process for the BOS takes about 20 to 30 minutes to
complete

9 Turnthe front key back to the upright (unlocked) position before the installation completes.

When the BOS installation completes, the installation program restarts your
computer. The key must be in the upright position during this restart to boot
from the hard disk instead of the CD.

The BOSis now installed, and you can customize your installation. The next
section lists the customization tasks that you need to perform to set up your
gystem initially.

Installing additional software

Once you have installed the BOS you need to install additional software, such
as the extensions to the A1 X operating system provided by Apple Computer.

To install additional software, use the Installation Assistant. After you have
installed the BOS your computer restarts and automatically starts the
Installation Assistant application. The Install Assistant application guides you
through the installation process and provides step-by-step instructions for
completing each task.

Installing additional software 15



To install additional software using the Installation Assistant:

Click Install Software Applications from the Installation Assistant Task List.

A menu appears with several items.

Click Install a Bundle of Software (Easy Install).

An Easy Install dialog box appears for additional installation information.
Specify the CD-ROM drive as the software source.

Select the All Licensed option as the bundle of software to install.

To select this bundle, you need to scrall to the bottom of the list of bundles
and click the All Licensed icon.

Click Install/Update.

The installation process begins. This process requires about 45 to 55 minutes
to complete

Click Exit.

When you dlick Exit, you exit Easy Install and return to the task list for the
Installation Assistant.

Click Tasks Completed—EXxit to AIX Login.

You must click the Tasks Completed option to quit this application to ensure
proper installation of the software.

Note: If you install from aterminal, atext-based Installation Assistant
installs additional software To install the necessary software with the text-
based | nstallation Assistant, choose the custom install option and select the
all _licensed bundletoinstall.

Performing initial setup and administration tasks

After you have installed the BOS and additional software, the system can run
with its default settings: one user (root), the date and time that was set when
the system was manufactured, and other general settings. However, you
probably want to customize these settings and provide additional information,
such as a network configuration.

16
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The Installation Assistant provides step-by-step instructions for completing
each customization task. The application also tells you why you would want to
perform certain tasks. If you are familiar with the tasks, you can ip the
instructions and smply complete the tasks

These are some of the tasks you may need to perform:
» Set the system date and time.

= Set aroot user account password and restrict access to system resources.
This step is vital to ensure the security of your computer.

» Set up your TCP/IP network environment.

For more information about configuring your TCP/I P environment, use
InfoExplorer to access the on-screen documentation. You can learn how to
use I nfoExplorer in Chapter 5 “Using InfoExplorer to Retrieve Information.”

= Change the primary language environment.
» Create user accounts

= Configure your printer and add print queues for local printers and remote
print servers. See Chapter 7, “Setting Up AppleTalk and AppleTalk
Services” to learn how to set up an AppleTalk printer and print queue

= Import any existing volume groups

= Back up your system. See “Backing Up Your System,” later in this chapter,
for information about backing up your system.

After youve finished your customization tasks, you can use the Installation
Assistant to log in to the system. Use the I nstallation Assistant task item
“Tasks Completed—EXxit to AIX Login” to quit the Installation Assistant and
ensure proper configuration.

You can access the I nstallation Assistant at any time by entering the
commandi nstal | _assi st.

For more information about any of these tasks, consult the on-screen
documentation with InfoExplorer.
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Setting your display resolution

After youve installed the operating system, you may want to customize your
display resolution.

To set your screen preferences, you need to log in to AlX. For information
about logging in, see Chapter 3
To set your screen preference:

Start SMIT.

To start SMIT, enter sni t on the command line See Chapter 6 for more
information about using SMIT.

Choose Devices.

The Devices menu appears.

Choose Graphic Displays.
The Graphic Displays menu appears.

Choose Display Resolution and Refresh Rate.

SMIT displays alist of available devices.

Click the device name.

A dialog box appears with the attributes for the device

Specify your resolution and refresh rate.
Use the List button to display the available resolutions and refresh rates.
For example, you can set your resolution and refresh rate to 1024x768@72Hz.

Click OK.

Restart your system.
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Backing up your system

After you have installed the BOS and performed your initial customization
and configuration, it is a good ideato create a system backup. You use a
backup to restore a corrupted file system and recover data.

You can use the Installation Assistant to create a backup after your initial
installation. You can also use the System Management I nterface Tool (SMIT)
to make a backup. SMIT uses the nrksysb command to create a backup image
that you can store either on atape or in afile If you choose to back up to
tape the backup program writes to the tape a boot image that you can use for
installation on other systems.

For more information on using SMIT, see Chapter 6 and use I nfoExplorer.

Configuring before the backup

Configure your system before you create a backup image if you want the
image to be identical and have the same users, passwords, network addresses,
and so on. However, if you plan to use the backup image to install the BOS on
other Network Servers, create the backup image before configuring the
system.

If you install the backup image on other systems, you might not want
passwords and network addresses copied. Using the same passwvords on many
systems can create a security risk, and copying network addresses creates
duplicate addresses and can disrupt communications

The BOS installation program automatically installs only the device drivers
required for the hardware configuration of the installed machine Therefore, if
you are installing a system backup on other machines, you may need to
install additional device drivers on the source system before making the backup
image

To install additional device support on the source system, use the Install
Additional Device Software SMIT menu item.
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Creating a backup
Follow the steps in this section to create a system backup.
1 Loginasroot.

2 Mount all file systems you want to back up.
Refer to the mount command for details

3 Freeat least 8.8 MB of disk space in the / t np directory or increase the size of your
disk partition.

The nksysb command requires this working space To determine the free
spaceinthe/ t np directory, use the df command. If necessary, use SMIT or
the chf s command to change the size of the file system.

4 Enter the following SMIT command:

smt nksysb

The Back Up the System screen appears.
5 Select how you want to store the backup.

Press F4 to list available tape devices

6 If you want to create map files, select the Create Map Files field.

Map files match the physical partitions on a drive to itslogical partitions

7 If you want to create a bootable backup, leave the default of yes. If you do not want a
bootable backup, press Tab to change the option to no.

8 Specify if you want to expand the / t np directory if you have a bootable backup.

9  Specify the number of blocks to write in a single output, or leave the field blank to accept
the system default.

20  Chapter 2/ Installing AIX on Your Network Server



10
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For afile backup, press Enter. For a tape backup, insert a tape and press Enter.
The Command Status screen appears.

If you are creating a tape backup, the system may prompt you to insert
another tape

When the backup completes, exit SMIT.

The backup is complete If you created a bootable tape, it can start your
system if you are ever unable to start it from the hard disk.

Verifying a backup tape

You can use the procedures in this section to view the contents of a backup
tape The contents list verifies most of the information on the tape, but it does
not verify that the tape can be used for installations The only way to verify a
boot image on atape isto try to start the system fromit.

To verify a backup tape:

Enter the following SMIT command:
smt | snksysb
The List Filesin a System | mage screen appears.

Type the number of blocks to read for your tape device, or leave the field blank to accept
the system default.

Either type the tape device name in the second field or accept the name provided.

Press the Enter key.
The Command Status screen appears listing the contents of the backup tape
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Installing the BOS from a system backup
You can install the BOS from a tape backup image.

Installing from a system backup reduces repetitive installation and
configuration tasks.

When you install a backup image, the system determines if the target system
has enough disk space to create all the logical volumes. If so, the entire
backup isinstalled. Otherwise, the installation program stops the system and
prompts you to select more destination hard disks

You can create a backup with SMIT using either the Backup the System menu
or the command nksysb -i TargetDevice See “Backing Up Your System,”
earlier in this chapter, for more information.

WARNING |f you are using a backup to configure many systems, make
sure that the backup image was created before the system was
configured with network information and addresses and user accounts
and passwords. Duplicating this information causes network problems
and security risks If you prefer, you can manually modify this
information on the new system after installation.

To install from a backup:

1 Putthe backup tape in the tape drive.

2 Shut down the system. Enter the command
shut down -F

3 Turn the front key to the left (service) position.

4 Turn on your computer.

The computer starts from the backup tape. Follow the instructionsin
“Installing the AIX Base Operating Systent’ earlier in this chapter.
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Restoring a corrupted file system

Once you have created a backup, you might need to restore information that is
lost or damaged.

To restore a file system from a tape backup:
1 Putthe backup tape in the tape drive.

2 Shut down the system. Enter the command

shut down -F
3 Turn the front key to the left (service) position.

4 Turn on your computer.
The computer starts from the backup tape
A message appears asking you to define the system console

5 Press F1 and then the Enter key to use the local display as your console.

You need an extended keyboard to identify your console unless you are
installing with aterminal connected to the modem port.

6 When prompted, select alanguage for installation instructions.
For English, type 1 and press Enter.
The following message appears on your screen.

Wel cone to the Base Operating System

Install ati on and Mai nt enance

Type the nunber of your choice and press Enter.

Choice is indicated by >>>.

1 Start install now with default settings

2 Change/ show install ati on settings and install
>>> 3 Start mai nt enance node for systemrecovery

88 HELP ?

99 PREVI QUS MENU
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7 Type 3 and press Enter.
A menu appears that lists options for system maintenance

Mai nt enance

Type the nunber of your choice and press Enter.

Choice is indicated by >>>.

>>> 1 Access a Root Vol une G oup
2 Copy a System Dunp to Renpvabl e Medi a
3 Access Advanced Mai ntenance Functions
4 Install froma System Backup
88 HELP ?

99 PREVI QUS MENU

8 Type 1l and press Enter.
The choice indicated by 1 lets you access aroot volume group.

When you choose 1, the system warns you that you might overwrite existing
information and then lists the available volume groups.

9 Type the number of the volume group that you want to restore and press Enter.

A menu appears that lists the file systems on this volume group.

10  Type the number of the file system that you want to restore and press Enter.

Your system lists options for mounting the file system.

11 Select Mount File System and Start Shell.

Your system mounts the file system and provides a shell for you to enter UNIX
commands to examine the file system from the backup and restore
information.

24 Chapter 2/ Installing AIX on Your Network Server



Installing Mac OS utilities on a Mac OS client

The software for the Network Server provides several Mac OS utilities to
perform such tasks as terminal emulation and remote administration of
disk storage.

You can install the Mac OS utilities on any computer running the Macintosh
Operating System.
Toinstall the Mac OS utilities on a Mac OS dient, follow these steps

1 Quit all other applications.

The installation program adds extensions to your System Folder and does not
allow other programs to be running during the installation process.

2 Insert the Mac OS Utilities for the Network Server With AIX disk.
Thisisa35-inch disk provided with the software for the Network Server.
3 Double-click the Installer icon.

A Welcome to AppleTalk Services dialog box appears

4 Click Continue.
A dialog box appears that provides installation options.

Installer Script "——————1715

[ Easy Install b |

Install all AppleTalk Services software to your hard disk.

-Destination Folder

E‘ Select Folder...
AppleTalk Services [ﬁ
an the disk “hammers0* Install

[
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Choose your type of installation from the pop-up menu in the upper-left corner of the
dialog box.
You can choose one of the following options:

= Easy Install, which installs all of the Mac OS utilities and necessary
additional components.

» Custom Install, which lets you specify the components to install. Click
the triangle to the left of “Everything” to view and select the components
to install.

Note: All Mac OS utilities require the Network Server Passwd Tool, and
CommandShell requires the CommandShell VT102 component.

= Custom Remove, which lets you remove Macintosh utility components
from your system.
Select the destination folder for the installation.

By default, the Mac OS utilities are installed in a folder named AppleTal k
Services, and the extensions are placed in the System Folder in the boot
system.

To change the disk for the installation, hold down the Option key. The Select
Folder option changes to Select System Disk. Use this option to specify the
installation disk.

Click Install.
The applications and components are installed on your system.
Once the installation is complete, restart your computer.

See Chapter 7, “Setting Up AppleTalk and AppleTalk Services” to learn how
to configure and set up Mac OS utilities.
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System Startup, Logging In,
Shutting Down, and Rebooting

This chapter describes how to begin and end awork session. It covers the
following topics:

= logging in and out
= rebooting
= shutting down the system




Before logging in

Logging in

This guide assumes that the following conditions have been met:

= You have the documentation for your computer and monitor hardware
available and that you are acquainted with the use of the hardware and any
necessary peripheral devices.

For detailed information on starting up and shutting down the Network
Server, see Sting Up the Network Server, which was packaged with the
Network Server.

= AlIX has been properly installed on the server. If thisis not the case, follow
the directions in Chapter 2.

= You have a user account and a password, or if you are administering the
gystem, you have root privileges and the root password.

Note: If you have problems booting AlX, consult the chapter “Starting Up
Your Server” in Stting Up the Network Server, where there is a description of
causes of Open Firmware problems and potential solutions Thereisalso a
description of error messages that might show up on the LCD during the
startup process

To use the system, you must identify yourself to the system as an authorized
user by logging in with your login name

The appearance of the login prompt depends upon whether your system is set
to log in from the command-line interface or from the graphical interface For
information on setting the system to log in to the graphical interface, see
“Setting Up Your System So That CDE Starts Automatically,” in Chapter 4.

Note: If your login prompt does not appear after you start up the system, see
“System Error Messages’ in Chapter 10.
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The login prompt for the command-line interface is

| ogi n:

For more information on the graphical interface login window, see the next
section, “The Graphical Interface Login Window” later in this chapter.
Type your login name following the | ogi n: prompt, and press Return.

| ogi n: LoginName

If the passwor d: prompt does not appear, you have no password defined,
and you can begin working with the operating system. If the passwor d:
prompt does appear, continue with step 2.

Type your password and press Return.
passwor d: YourPassword
The screen does not display your password as you typeit.

If the system displays an error message stating that your login isincorrect, log
in again and enter the correct login name and password.

Remember that UNIX is case senditive, that is, you must enter the login name
and passwvord using the same lowercase or uppercase characters that were
used when the name and password were assigned. Thus, if your login nameis
johnson, you will not be able to log in as Johnson.

Note: The root password is also the passwvord for Open Firmware

After you have logged in and depending on how your system is set up, your
gystem will start up in agraphical interface (Al1Xwindows or Common
Desktop Environment) or in a command-line interface (the shell).
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Shutting down

The graphical interface login window

The graphical interface login window contains an Options button that allows
you several options. For example you can change to a command-line login
as follows:

Click the Options button.

Choose Command Line Login.

A message appears that tells you to press any key to display the login prompt.
Press any key.

Thel ogi n: prompt appears.

The Options menu also offers the following options:

= Language Allows you to change the session language.

= Session. Allows you to choose Regular Desktop (the Common Desktop
Environment) or Failsafe session (an X windows environment).

= Reset Login Screen. Restarts the X server.
To delete what you have typed in the Login field, dick the Start Over button.

From the user’s viewpoint, stopping (shutting down) a system is smple, but
from the systemis viewpoint, the shutdown process involves a series of events
designed to preserve file integrity.

The safest and most thorough way to halt the operating system is to use the
shut down command. When you designate the appropriate command options,
the shut down command notifies users that the system is about to stop
operations, terminates all existing processes, unmounts file systems, and
shuts down the system.
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The steps that take place during a system shutdown depend on how the
gystem was customized. The shutdown described in this section may not
appear exactly the same on your system.

Note: You must have root privileges to shut down the system.

To shut down the system:

= Atthe prompt, enter
shut down
that is, type the command and then press Return.

By default, the system waits one minute before stopping the user processes
and the init process. You will see the following message:

shut down conpl et ed. ..

Rebooting the system

A system reboot recopies the operating system from disk to memory and starts
it without turning the system completely off. A reboot is also known as a
system reset. It reinitializes the operating system by repeating the initial
program load (IPL) operation. When the system is first turned on, the
operating system is usually booted automatically.

When the - r option is specified with the shut down command, the system
reboots after it completes the shutdown.
= Atthe prompt, enter
shut down -r
The system shuts down and reboots.

You can also use ther eboot command. If no other users are logged into the
system, use ther eboot command to cause the system to recognize newly
installed software, to reset peripheral devices, or to perform routine

mai ntenance tasks, such as checking file systems.

The shut down command is used instead of the reboot command when the
system is running and other users are logged in.
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The steps that take place during a system reboot depend on how the system
was customized. The reboot process described in this section may not be
exactly the same on your system.

Note: You must have root privileges to reboot the system.
At the prompt, enter

r eboot

The system reboots.

Shutting down to single-user mode

In some cases, you may need to enter single-user mode (also referred to as
maintenance or standalone mode) in order to perform software maintenance
and diagnostics. To shut down the system to single-user mode, the current
directory must be the root directory, and you must have root privileges

Be sure that you are working in the root directory by entering

cd /

Enter
shut down -m

The system shuts down to single-user mode. A system prompt appears, and
you can perform mai ntenance activities.

Shutting down quickly

Use the following procedure to stop the system quickly without notifying
other users

At the prompt, enter

shut down -F

The - F option instructs the shut down command to bypass sending messages
to other users and to shut down the system as quickly as possible
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Using AlXwindows and
the Common Desktop Environment

This chapter describes the use of the AlXwindows interface, which allows
you to manage the aixterm terminal windows and any other X dient windows
on your screen. It covers the following topics:

starting and using the Al Xwindows interface
working with menus in the AlXwindows interface
manipulating icons

using the Common Desktop Environment




Introduction to AIXwindows
AlXwindows runs aterminal emulator (ai xt er m) in aterminal window. The
AlXwindows interface allows you to
= run several programs simultaneoudy on a single screen
= create multiple windows to meet your specific needs
= Ccut and paste text between windows
= control various terminal functions

Note: Many of the commands described in this chapter use the Alt key. If
your keyboard does not have an Alt key, use the Option key inits place

Starting AIXwindows from the command line

When you log in to your system, you start in either the command-line
interface, AlXwindows, or Common Desktop Environment, depending on
how your system is set up. If you start up in the command-line interface, start
AlXwindows by entering the following command:

Xinit
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Elements of the AIXwindows interface

Window menu button

Resize handle

Client area

When AlXwindows starts, an aixterm terminal window appears that contains
the elements shown in the following illustration:

Title bar Minimize button

alxterm - Maximize button

Resize handle

Resize handle

The elements of the window are described here:

Client area. The input and output of the program take place here
Resize handles Point to aresize handle and drag it to change the window sze

Title bar. Thetitle of the program or other specified information is
displayed.

Window menu button. Click the window menu button to display the
Window Manager menu.

Minimize button. Click the minimize button to convert the window to an
icon.

Maximize button. Click the maximize button to expand the window to its
maximum size (often the full screen), or to contract it to its previous size
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Mouse pointer shapes

When AlXwindows starts, an X-shaped mouse pointer appears at the center
of the screen. The pointer shape changes according to its location. For
example, when the pointer is directly over the root window (the background
behind all windows), the pointer has an X shape. When the mouse points
insde aterminal window, the pointer changesto an I-beam shape A
description and illustration of pointer shapes follows.

Arrow pointers

%

An arrow pointing to the upper-left corner is the general -purpose pointer
used in most window areas for selecting and activating single objects.

A

An arrow pointing to the upper-right corner indicates a pending menu action.
This shape indicates that a menu is popped up or pulled down and that you
must choose a menu item or release the menu.

Caution pointer

-

The caution pointer indicates that some action is expected in another area
before you can give input to the current area. All mouse and keyboard actions
are ignored in the area where the caution pointer appears
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Four-directional arrow pointer

4

The four-directional arrow pointer indicates that a move operationisin
progress. During a move operation, the object, or an outline of the object,
tracks the location of the pointer.

Hourglass pointer

K

The hourglass pointer indicates that an action isin progress in the area. While
the hourglass pointer is active, all mouse and keyboard actions are ignored in
the area. The hourglass pointer and the watch pointer (shown later in this
section) mean the same

I-oeam pointer

1

The I-beam pointer indicates where you can perform actions on the text and
changes the location of the text-insertion cursor.
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Resize pointer

XA

PRI

The resize pointer indicates that the pointer is at one of the resize bars of the
window. The direction of the arrow indicates the direction in which you move
the pointer to increase the size of the window. The horizontal and vertical
pointers indicate that the window is changed in either the horizontal or
vertical direction. The diagonal pointersindicate that the window is changed
in both the horizontal and vertical directions simultaneoudy.

Sighting pointer

_I_

The sighting pointer is used to make precise position selections. For example,
in adrawing program, it may be used to indicate a pixel to fill or the
connecting points of lines

Watch pointer

0,

See “Hourglass Pointer,” earlier in this section.

X pointer

X

The X pointer indicates that the pointer is outside any application area.
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Selecting a window

To activate awindow so that it can receive input:

= Point to any part of the window and click the mouse button.

The window frame changes color.

The Window Manager menu

The Window Manager menu (which is often referred to as the window menu)
allows you to perform the most important window-manipulation tasks

To display the Window Manager menu:

= Click the Window Manager menu button (to the left of the window’s title bar) with the
mouse button. You may also press the Shift-Esc or the Alt (or Option)-Spacebar key
combination while pressing the left mouse button.

The Window Manager menu contains the following items:

Restore Restores a window from an icon or to its previous size

Move Changes the location of the window (see “Moving a Window” later
in this chapter).

Sze Changes the size of awindow (see “Resizing aWindow” later in
this chapter).

Minimize Turns the window into an icon.
Maximize Enlarges the window to cover the entire root window.

Lower. Sends a window to the back or bottom of the window stack, the
position dosest to the root window. If the window is active, it remains
active until another window is made active.

Close Immediately stops the process running in the window and closes
the window.

To cancel the Window Manager menu:

= Press Esc (the Escape key).

The Window Manager menu 39



Choosing a menu item
To choose a menu item, follow these steps:
1 Display the menu.

2 Hold down the mouse button and drag the pointer down the menu until the item you wish
to choose is highlighted.

3 Release the mouse button.

You can also press the accelerator keys (shown to the right of the menu items)
without displaying the menu, or you can press the underlined mnemonic
characters with the menu displayed.

Displaying the root menu

The root menu offers several options for controlling your AIXwindows
interface

To display the root menu:
1 Point to the root window (the background behind all other windows).

2 Press and hold the right mouse button (or the Right Arrow key).

You can customi ze the root menu. See the article “Managing AlXwindows
Menus, Mouse Buttons, and Keyboard Bindings’ in InfoExplorer (whichis
described in Chapter 5). By default, the root menu contains the following
items:

= New Window. Opens a new aixterm window.

= Clients Opens a submenu that allows you to display a new clock, open the
System Management I nterface Tool (SMIT), or lock the screen.

» Custom. Opens the Customizing Tool interface for customizing
applications.

= Refresh. Refreshes the screen.

= Pack Icons. Arranges all icons on the screen in one or more neat rows
» Restart. Restarts the Window Manager.

= End Session. Quits AlXwindows.
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Moving a window

You can move windows using the mouse or the Move item in the Window
Manager menu.

= Pointin the window’s title bar, and drag the mouse pointer in the appropriate direction.

If you prefer, you may use the following procedure:
1 Choose Move from the Window Manager menu.
2 Pointin the window and drag the window to its new position.

3 When the window reaches the new location, press the Return key or click any mouse
button.

Note: To cancel the move, press Esc before you release the mouse button.

Opening a new terminal window
To open a new terminal window:

= Choose the New Window menu item from the root menu.

If you prefer, you may use the following procedure:

= Atthe promptin a window, enter
ai xter m&
A new window is displayed, usually 80 characters wide and 25 lines long.
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Bringing a window forward or moving it back

You can use any of three methods for moving a window forward and
backward (in other words, on top of or beneath other windows).

= Click in any visible portion of a window frame.
If the window is behind other windows, it becomes the active window and
moves to the front.

= Display the root menu and choose Shuffle Up to move the window at the bottom
of the window stack to the top, or choose Shuffle Down to move the window at the
top of the window stack to the bottom.

= Display the Window Manager menu and choose Lower (or press the L key), or you can
press the Alt (or Option)-F3 key combination.

The frontmost window moves behind the other windows.

Note: If you use the Lower menu item to move the active window behind
the other windows, the active window stays active until another window is
made active

Resizing a window
You can change the size of awindow using the mouse, the Window Manager
menu, or a combination of the mouse and keyboard.
1 Point to an edge or corner of the window frame.
2 Drag the edge or corner to increase or decrease the size of the window.

3 When the window reaches the desired size, release the mouse button.
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If you prefer, you may use the following procedure:

1 Display the Window Manager menu and choose Size (or press the | key), or you can
press the Alt (or Option)-F8 key combination.

A counter appears in the center of the screen, showing the size in characters
of the window as it changes; the outline of a rectangle surrounds the window.
Use the mouse to expand or shrink the window.

2 When the window reaches the desired size, press the Return key, or click any mouse
button.

Note: To cancel the resizing, press Esc before you rel ease the mouse button.

Maximizing a window and restoring it to its previous size

You can maximize awindow by expanding it to the full size of the screen.

= Click the maximize button (at the extreme right of the title bar) with the mouse button.

If the window is aready maximized, this action returns the window to its
previous size
If you prefer, you may use the following procedure:

= Display the Window Manager menu and choose Maximize (or press the X key) , or you
can press the Alt (or Option)-F10 key combination.
To return awindow to its previous size:

= Display the Window Manager menu and choose Restore (or press the R key), or you can
press the Alt (or Option)-F5 key combination.
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Closing a window

When you quit an application that is running within its own window, the
window usually closes However, if you must close a window yourself, do
the following:

= Double-click the window menu button.

If you prefer, you may use the following procedure:

= Display the Window Manager menu and choose the Close menu item (or press the S
key), or you can press the Alt (or Option)-F4 key combination.

Changing windows into icons and restoring windows from icons
To change awindow into an icon, do the following:
= Click the minimize button (on the right side of the title bar, but to the left of the
maximize button).
If you prefer, you may use the following procedure:

= Display the Window Manager menu and choose the Minimize menu item (or press the N
key), or you can press the Alt (or Option)-F9 key combination.

In either case, the window disappears and its icon appears

To restore a window from an icon:

= Double-click the icon or, with the icon selected, press the Alt (or Option)-F5 key
combination.
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Getting help in a window

There are various tools available to help you when you need more
information about commands or about the operating system.

= The InfoExplorer program, an on-screen hypertext information base,
allows you to display and print items from IBM’s on-screen documentation
(see Chapter 5).

= Thehel p command displays information about basic commands

= Theman command displays information about all commands, subroutines,
and files

Using the hel p Command

The hel p command presents a one-page display of information for new
users. Use this command as follows:

= Atthe promptin aterminal window, enter

hel p

The system displays information as shown in in the following figure
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Exiting and logging out from AIXwindows

Before exiting Al Xwindows, stop any programs that are running in terminal
windows This avoids loss of data.

When you exit a program, the command-line prompt returns to the terminal
window. However, if you started the program automatically or from a menu,
exiting removes the terminal window.

Choosing Close from the Window Manager menu immediately stops any
program running in the window. Interrupting a program like this may cause it
to lose data. However, you can close the clock or an idle terminal window
(one showing a command-line prompt) with no ill effect.

To exit AlXwindows:

= Select End Session in the root menu.

Copying text between windows

When you have text in aterminal window, the ai xt er mprogram allows you
to select text and copy it within the same window or to other windows if the
application that is running in the window supports this feature

To copy text from one window into another window:

1 Have the window you want to copy from and the window you plan to copy into open on
your screen.

2 Point to the beginning of the text you want to copy.
3 Press and hold down the mouse button.

4 Drag the pointer across the text you want to copy and release the mouse button at the
end of the selection.

While the mouse button is held down, the text to be copied is highlighted.
5 Move the mouse pointer to the window in which you want the copied text to be inserted.

6 Press the middle mouse button (or the Left Arrow key, if you are using a one-button mouse).

The copied text isinserted at the cursor's position.
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The aixterm menus

Usually, the aixterm menus are divided into two sections separated by a
horizontal line The top portion contains various modes that can be toggled
on or off. A check mark is displayed next to a mode that is currently active
Choose one of these modes to reverse its state

The bottom portion of the menu contains the command entries; choose one
of these to perform the action indicated.

The aixterm Options menu
To display the aixterm Options menu:

1 With the mouse pointer anywhere inside the window, press and hold down the Control
key and the mouse button.

2 When the aixterm Options menu appears, release the Control key.

3 While still holding down the mouse button, drag the pointer to the item you want to set or
reset, and then release the mouse button.

For instructions on using this menu, consult the article “Basic aixterm Tasks’
in InfoExplorer. InfoExplorer is described in Chapter 5

The aixterm Modes menu
To display the aixterm Modes menu:

1 With the mouse pointer anywhere inside the window, press and hold down the Control
key and the right mouse button (or the Right Arrow key, if you are using a one-button
mouse).

2 When the aixterm Modes menu appears, release the Control key.

3 While still holding down the right mouse button (or the Right Arrow key, if you are using
a one-button mouse), drag the pointer to the item you want to set or reset, and then
release the mouse button (or arrow key).

For instructions on using this menu, consult the article “Basic aixterm Tasks’
in InfoExplorer. InfoExplorer is described in Chapter 5
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Using the Common Desktop Environment

Help volumes, InfoExplorer information, and IBM’s hard copy manuals may
refer to the Common Desktop Environment (CDE) as Al Xwindows Desktop,
Common Desktop Environment desktop the CDE desktop CDE, or simply, the
desktop. From this point on, this guide uses the term CDE.

CDE allows you to access networked devices and tools without having to use
the command line You can exchange data across applications smply by using
your mouse to drag and drop objects

For more information on CDE, consult InfoExplorer (described in Chapter 5)
or Common Desktop Environment 10 User's Guide (CDE Documentation
Group, Addison-Wed ey Publishing Company, 1995).

Starting CDE from the command line

If you log in from the login window in graphic mode (described in the
section “Logging In,” Chapter 3), CDE starts automatically. If CDE is not set
to start automatically on your system, use the following command to start
CDE from the command-line interface:

xinit /usr/dt/bin/dtsession

Setting up your system so that CDE starts automatically

You can use any one of three ways to configure your system so that CDE
starts automatically:

= from the command line

= Wwith the System Management Interface Tool (SMIT)

» With SMIT fastpath

This section tells you how to configure CDE autostart from the command
line For information on configuring CDE autostart with SMIT or with SMIT

fastpath, use InfoExplorer, described in Chapter 5, to locate the article
“Starting and Stopping the A1X Common Desktop Environment.”
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To configure CDE autostart from the command-line interface:

Enter the following command:
/usr/dt/bin/dtconfig -e

Reboot the machine.

To disable CDE autostart:

Enter the following command:
/fusr/dt/bin/dtconfig -d

Reboot the machine.

Elements of CDE
The CDE front panel appears.

Application Help

Workspace
Application switch button

The following paragraphs describe the icons displayed along the bottom of
the desktop.

Calendar
Click the Calendar icon to display a calendar application.

File Manager

Click the File Manager icon to display the File Manager. Use the File
Manager to handle desktop objects (such asfiles, directories, and application
icons) which you can manipulate without having to remember commands.
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Text Editor

Click the Text Editor icon to open a Text Editor window. Click the Help
button in the Text Editor window for information on using Text Editor.

Personal Applications menu

Click the arrow above the Text Editor icon to open the Personal Applications
menu, which contains the following items:

= Install Icon. Adds applications to the front panel. For assistance, click
Install Icon with the right mouse button and select Help.

= Text Editor. Opens a Text Editor window.
= Terminal. Opens a new terminal window.

= Icon Editor. Opens an Icon Editor dialog box. For assistance, click the Help
button in the Icon Editor dialog box.

Mail Application

Click the Mail Application icon to display an application for sending and
receiving mail.

Screen lock

Click the lock icon to lock the screen and display a dialog box that asks for
the user’'s password to unlock the screen.

Workspace switch button

Click the numbered buttons to switch between four different screens with
different applications running in each.
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Exit
Click Exit to begin the logout process.

Printers

Click the arrow above the Printers icon to display the Personal Printers menu,
which contains the following items:

= Instal lcon
s Default Printer

Style Manager

Click the Style Manager icon to display a dialog box that allows you to
customize the visual appearance or the behavior of your desktop.

Application Manager

Click the Application Manager icon to display the Application Manager,
which contains a variety of action icons that alow you to start applications
Click the Application Manager Help button for more information.

Help Manager

Click the Help Manager icon to display awindow that introduces you to
desktop help. Click the arrow over the Help Manager icon to display the Help
menu. For a description of the menu items, see “Using the Help Menu’ later
in this chapter.

Opening a terminal window on CDE

The default terminal emulator on CDE is the dtterm window, which is
discussed in the following sections.
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Opening a dtterm window on CDE

To open a dtterm terminal window on CDE when no terminal windows are
currently open:

1 Click the arrow just above the Text Editor icon at the bottom of the screen.

The Personal Applications pop-up menu appears.

— |Personal Applications

= nstalliean

E\ iext Editer

erminal

2 Choose Terminal from the pop-up menu.

A dtterm window appears.

If adtterm window is already displayed, you can use the steps listed above to
open a new dtterm window, or you can do the following:

= Choose New from the Window menu of an existing window.

The dtterm menus are described in the next section, “Using the dtterm
Window” later in this chapter.

Opening an aixterm window on CDE
To open an aixterm window on CDE, do the following:

= Inadtterm window, enter
ai xter m&
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Using the dtterm window

The dtterm window operates much like the aixterm window that is described
earlier in this chapter. However, the aixterm menus do not operate in dtterm.
Instead, dtterm has a menu bar available that allows you to open a Window
menu, an Edit menu, an Options menu, and a Help menu. If the menu bar is
not displayed, you can display it by choosing Toggle Menu Bar from the
Window Manager menu (see the next section, “ The dtterm Window Manager
Menu’) or by pressing the right mouse button (or the Right Arrow key, if you
are us ng a one-button mouse).

Like other terminal windows, the dtterm window has a Window Manager
menu, which you display by pressing the Window Manager button at the
upper-left corner of the dtterm window. The illustration shows the Window
Manager button and the menu bar.

The dtterm Window Manager menu
The dtterm Window Manager menu offers the following options:

= Restore Restores a maximized screen to its original size See“Maximize’
later in thislist.

= Move Allows you to move the window by repositioning the mouse pointer.
End the move by dlicking the mouse button.

= Sze Allows you to resize the window by moving the pointer to the border
you wish to change, then moving the border to its new position. End the
resizing by clicking the mouse button.

s Minimize Turns the window into an icon.

= Maximize Expands the window to occupy the full screen. Restore it to its
original size by choosing Restore from this menu.

» Lower. Sends awindow to the back or bottom of the window stack, the
position dosest to the root window. The window remains active until
another window is made active
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= Occupy Workspace Displays a menu that allows you to display the window
in aworkspace other than the one it currently occupies. You can also
choose to replicate the window in all workspaces. See “Workspace Switch
Button” under “Elements of CDE" earlier in this chapter.

= Occupy All Workspaces. Replicates the window in all workspaces. See
“Workspace Switch Button” under “ Elements of CDE” earlier in this chapter.

= Unoccupy Workspace Removes the window from the current workspace if
it occupies more than one workspace

= Close Closes the window. Applications running in the window are
stopped.

= Toggle Menu Bar. Removes or redisplays the menu bar.

The dtterm Window menu

The Window menu contains two items:

= New. Opens a new dtterm window.

= Close Closes the current dtterm window.

The dtterm Edit menu

The Edit menu contains two items:

= Copy. Saves highlighted text to be copied.

= Paste Places copied text at the cursor position.

The dtterm Options menu
The Options menu contains the following items:

= Menu Bar. Toggles the menu bar on and off. To toggle the menu bar back
on, choose Toggle Menu Bar from the Window Manager menu, or press
the right mouse button (or the Right Arrow key) and choose Menu Bar
from the Options menu.

= Scroll Bar. Toggles the scroll bar on and off.

= Global Options. Displays the Global Options dialog box. See
“dtterm Global Options Dialog Box” next in this chapter.

= Terminal Options. Displays the Terminal Options dialog box. See
“dtterm Terminal Options Dialog Box” later in this chapter.
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» Window Sze Offersthe choice of 80 X 24, 132 X 24, or Default.
» Font Sze Offers several window-font sizes.
» Reset. Offers a choice of hard or soft reset.

dtterm Global Options dialog box

Choose Global Options from the dtterm Options menu to display the Global

Options dialog box.

Blinking Cursor | Enabled —

Blink Rate (millisecond

Scroll BEehavior

Smooth Scrolling |Disabled —
Bell Cantral
Bell Type |Audible —
hargin Warning |Disabled —

Reset Apphy Cancel Help

The Global Options dialog box allows you to control the following:
= cursor style and blink rate

= window background color control (normal or inverse)

= smooth scrolling enabled or disabled

bell type and margin warning

For additional information, dick the Help button at the bottom Ieft of the
dialog box.
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dtterm Terminal Options dialog box

Choose Terminal Options from the dtterm Options menu to display the
Terminal Options dialog box.

diterm — Terminal Options
~eyboard Control
Cursor Key hMode | Mormal —
Keypad Mode | Mumeric —

Mewline Sequence Return Onky —

User Function Keys |Unlocked —

Screen Control

End-of-line Wrapping | Enabled —

Feverse End—of-line Wrapping |Disabled —

Feset Apply Cancel Help

The Terminal Options dialog box allows you to control the following:

s Cursor Key Mode Sets the mode to Normal mode (the default), to move
the cursor in the specified direction, or Application, to generate escape
sequences for an application to use

» Keypad Mode Sets the mode to Numeric mode (the default), to display the
numeral corresponding to the key pressed, or Application, to generate
escape sequences for an application to use

= Newline Sequence Allows you to choose between Return Only (the
default), which generates a carriage return, and Return/Line Feed, which
generates aline feed and a carriage return.
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User Function Keys. Locks or unlocks the function keys.

132 Column Switching. Disables (the default) or enables 132-column
switching. When 132-column switching is enabled, if an application
switches to 132 columns, the window automatically enlarges to 132
columns. If 132-column switching is disabled, nothing happensiif the
application switches to 132 columns

End-of-line Wrapping. Enables (the default) or disables wrapping text to
the next line when the end of the line is reached.

Reverse End-of-line Wrapping. Disables (the default) or enables wrapping
a backspace at the beginning of aline to the previousline

The Workspace menu

To display the Workspace menu, hold down the right mouse button while the
mouse pointer is on the desktop background. By default, the menu contains
the following items:;

Shuffle Up. Moves the rearmost window to the top of the stack of
windows.

Shuffle Down. Moves the top window in the stack to the bottom of the
stack.

Minimize/Restore Front Panel. Turns the front panel into an icon or
restores it.

Refresh. Refreshes the screen.
Restart Workspace Manager. Restarts CDE.

Logout. Displays a Logout Confirmation dialog box, which allows you to
proceed with the logout or to cancel it.

Using the Common Desktop Environment 57



Using CDE Help
Thefirst time you log in to CDE, a help window introducing the desktop is
displayed that provides quick access to helpful topics

= To display information about using desktop menus and controls and other
introductory topics, dick the topic “Basic Desktop kills”

» Click the topic “A Quick Tour of the Desktop” for an introductory review of
the types of applications available in the CDE environment.

= Click the topic “How to Get Help’ for details about accessing and using
CDE Help.

Accessing CDE topics
You have a number of ways to access CDE Help topics:

= Help key. The quickest and easiest way to get help isto press F1,
usually known as the Help key. When you press F1, the application you
are using responds by displaying the help topic most closely related to
your current activity.

= Help Manager. To access the extensive CDE Help volumes:

1 Click the Help Manager icon located on the CDE front panel.

=
il

When you dick the Help Manager icon, the Help Manager dialog box
appears, which contains a hypertext-linked list of all the help volumes that
support

the desktop.

2 Inthe Help Manager dialog box, click “Common Desktop Environment (CDE)" to display
the list of help volumes that have been installed on your desktop.

Browse thelist of titles.

3 Toopen avolume, click its title.
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Using the Help menu

To view the Help menu and its available items, click the arrow above the Help
Manager icon.

The Help menu contains the following items:

Install Icon. Adds applications to the front panel. For assistance, click
Install Icon with the right mouse button (or the Right Arrow key) and
select Help.

Help Manager. Displays the Help Browser help volume, which gives you
access to the installed desktop help volumes on the system.

Desktop Introduction. Displays the help volume titled “1ntroducing the CDE
Desktop,” which contai ns topics covering basic desktop concepts and sills
This help volume appears automatically the first time a user logsin to
CDE.

Front Panel Help. Displays the help volume for the front panel; it contains
information on how to use and customize the front panel.

On Item Help. Changes the pointer to a question mark that you can drag
and drop on desktop objects for specific information on those objects.

Special Circumstances

If you need to start applications on a workstation other than your own, and
that workstation is also running the CDE desktop, you may need to do some
configuring on both workstations.

Also, if your CDE desktop has one of the following special configurations,
you may need to change certain Login Manager files before starting CDE:

= Your system console is an ASCII terminal.

= Your systemisan X terminal or ahost for X terminals.
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Using InfoExplorer to Retrieve Information

This chapter presents an overview of the use of InfoExplorer, IBM’s
information retrieval system.

This chapter covers the following topics:

using InfoExplorer's graphical interface
using InfoExplorer's ASCII interface
navigati ng through | nfoExplorer
searching by word and phrase
customizing | nfoExplorer




Introduction to InfoExplorer

The Hypertext Information Base Library contains information on how to use,
manage, and program the Al X operating system and other programming
language software. |nfoExplorer allows you to find all information in the
Hypertext Information Base Library, and thus serves as a complete on-screen
information source

Starting InfoExplorer

2

You can view InfoExplorer in the InfoExplorer graphical interface or the
InfoExplorer ASCII interface

Starting InfoExplorer in graphics mode

There are two ways to start | nfoExplorer in graphics mode. If CDE is
displayed, you may do the following:

Double-click the Application Manager icon.

2|

In the Application Manager window, double-click the Information icon.

Information
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3 Inthe Application Manager - Information window, double-click the InfoExplorer icon.

ie]

InfoExzplorer

If you are working in the command-line interface, do the following:

= Enter the command

info -g

You may start I nfoExplorer from aterminal window in AlXwindows or CDE
as follows:

= Enterthei nf o command.

By default, two windows appear:

= A havigation window containing, by default, the artide “Topic & Task
Index.” This default can be changed. See “ Customizing the InfoExplorer
Graphical Interface’ later in this chapter.

= A reading window that contains the article “Welcome to the InfoExplorer
Window Interface” which shows you how to perform basic window
operations

The navigation window has two rows of buttons at the bottom of the window
that offer avariety of options for navigating through the information database

For further information on InfoExplorer in graphics mode, see “Using the
InfoExplorer Graphical Interface” next in this chapter. For further
information on types of windows used by InfoExplorer, see “InfoExplorer
Windows' later in this chapter.

For information on starting and using InfoExplorer in ASCIl mode, see
“Using the InfoExplorer ASCII Interface’ later in this chapter.

For information on the command options that you can use with thei nf o
command, see “Thei nf o Command Options’ later in this chapter.
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Using the InfoExplorer graphical interface

The following paragraphs describe the use of the graphical interface

Using InfoExplorer to learn InfoExplorer (graphical interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing

Information With InfoExplorer,” of IBM’s Al X \erson 41 Getting Sarted. If

you are planning to use the InfoExplorer ASCII interface, see “Using

InfoExplorer to Learn InfoExplorer (ASCII Interface)” later in this chapter.
1 Click the List of Books button at the bottom of the navigation window.

The List of Books appears.
2 Inthelist headed “Base Operating System Books,” click AIX Version 4.1 Getting Started.
3 Scroll down to Chapter 7.

4 Click the title of the section you wish to consult.
The text is displayed.

5 If you wish to print the article, choose Print from the Info menu (in the menu bar of the
reading window).

Highlighting conventions in InfoExplorer articles

The Hypertext I nformation Base Library uses the following font and
highlighting conventions:

» Bold identifies commands, keywords, files, directories, and other items
named by the system.

» ltalicsidentifies parameters for which you supply the names or values.

m Couri er identifies examples of specific data values, displayed text, portions
of program code, messages from the system, or information you enter.
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InfoExplorer windows

InfoExplorer uses two basic types of windows: navigation windows and
reading windows

Navigation windows

Navigation windows help you navigate to the articles contai ning the information
you want. Navigation windows contain lists of topics with hypertext links
The hypertext links are enclosed in boxes. They alow you to display articles
on the specific topic. Only one navigation window can be displayed at atime
The contents of the navigation window are replaced each time you display
another navigation window.

e
Topic & Task Index

Jopic & Task Index
[&bout the Topic & Task Index

The buttons at the bottom of the Navigation window are described briefly in
the following table
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Button Material displayed

Topic & Task Index A list of tasks and topics grouped by subject area

List of Commands Information on commands listed alphabetically and by functional
categories

List of Books A list of AIX documents available with InfoExplorer

Programming Reference Programming reference information arranged under major functional
categories that are listed alphabetically

History A list of all InfoExplorer locations accessed since starting
InfoExplorer or clearing the History list

List of Bookmarks A list of bookmarks used to mark places in the InfoExplorer database
for future reference

List of Notes Notes you have made about the information you have accessed

Path The path of your information search through InfoExplorer

Search A simple or a compound search window for entering words and

phrases and criteria for your search through the database

Reading windows

Reading windows contain conceptual, procedural, or reference information
on atopic. They explain how to perform atask, or they document commands,
cals, subroutines, files, or file formats You can display more than one
reading window at atime (with the Hold button), or you can have the
contents of the window replaced each time you select more information.

You can dick the following buttons that appear at the bottom of areading
window in order to perform the actions indicated:

= Make Note Creates a note and places a note icon in the text. Click the Up
Arrow button to jump to the previous note; click the Down Arrow button
to jump to the next note

= Make Bookmark. Creates a bookmark in the text. Click the Up Arrow
button to jump to the previous bookmark; click the Down Arrow button to
jump to the next bookmark (if you have previoudy loaded alist of
bookmarks).
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= Path. Displays your path list. You can jump to any article in your path list,
or you can clear or modify the path list. Click the Up Arrow button to
jump to the previous item; click the Down Arrow button to jump to the
next item on your path list.

s Search. Searches the InfoExplorer or other databases for specific terms
or phrases

At the top of the window, there are three buttons that you can cdlick to activate
readi ng-window functions:

» HideLinks Altersthe text so no links show. To hide links, click the Hide
Links button. To show all links, release the Hide Link button by clicking
it again.

» Hold. Opens an artide in a new window without replacing the original
artide

s Close Closes the reading window.

MWelcome to the InfoExplorer Window Interface

With InfoExplarer, you can access software and hardware information in an
online information base consisting of articles connected by hypertest drgs. &
hypertext link is a one-way path from one piece of information to another.

ltems in InfoExplorer text that appear in boxes are hypertext links. To follow a
link to view mare infarmation related to the current article, move your mouse
pointer inside one of the following boxes and click the left mouse button:

. [Basic InfoE=plarer Window Operationg|
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Using InfoExplorer graphical interface Help

From an InfoExplorer window, you can view help information about the
functions and options available for the current window, or you can search
through alist of topics for the appropriate help information.
Displaying Help for a specific window
The Help menu in each window contains an On Window item, which
displays an article describing the function, menus, and buttons that are
available in the current window.
To display help for a window:

1 Click Help in the menu bar to display the Help menu.

2 Choose On Window.
A help article opensin a new reading window,

Getting Help from the List of Helps
The Help menu in each InfoExplorer window contains a List of Helps item,

which displays alist of InfoExplorer help topics. The help articles display the
information and procedures for awide range of taks
To use the List of Helps:

1 Click Help in the menu bar to display the Help menu.

2 Choose List of Helps.

3 Click the desired help topic.
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Searching for information

InfoExplorer allows you to look for information by word or phrase This type
of search looks through the entire text of the hypertext information base For
example, you can search for information even if you do not know atask or
command name under which the information is stored.

You can perform a smple search or a compound search. The smple search
allows you to search using aword or string of words (in exact order) in text,
article titles, or both. The compound search allows you to search usng a word,
set of words, or several sets of words. Moreover, the compound search allows
you to specify the search with the following options:

= And, Or, and But Not operators
= proximity options

» Search categories

» precedence

Specifying the databases to search
There are two ways to specify the information databases to be searched:

» Select atemporary information database in the Compound Search window.
This selection applies to both smple and compound searches and staysin
effect for the current session of InfoExplorer or until you change the
selection during the session.

» Select adefault information database by choos ng Defaults from the
Options menu (see “ Customizing the I nfoExplorer Graphical Interface’
later in this chapter). This default information database applies to both
simple and compound searches and stays in effect for future sessions of
InfoExplorer. Temporary information database sel ections made from the
Compound Search dialog box can override the default selection during
an InfoExplorer session, but the default selection returns when you restart
InfoExplorer.
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The simple search
You can perform a simple search as follows:

Click the Search button at the bottom of the navigation window.

The Simple Search dialog box appears.

Type the phrase for which you are searching in the Search For field and press Return.
A list of articles on the smple search appears.
If you wish to print the article, choose Print from the “info” menu.

For an on-screen tutorial about performing a simple search, follow the
directionsin “Using InfoExplorer to Learn InfoExplorer (Graphical
Interface),” earlier in this chapter, to find the section “Searching for
Information (I nfoExplorer Windows)” in Chapter 7 of IBM’s Al X \&rsion 41
Getting Sarted.

The compound search

If the Smple Search dialog box appears when you dick the Search button in
the navigation window, click the Compound Search button at the bottom right
of the Smple Search dialog box. The Compound Search dialog box appears.
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This dialog box alows you to enter four text strings. You can specify
the following:

= The buttons along the left of the last three text boxes allow you to choose
the And, Or, or But Not operators.

= You may specify whether the strings should appear in the same article
or paragraph.
= You may specify how far apart they must be within a paragraph.

= You may choose the databases, categories, and fields in which they
must appear.

For more information about compound searches, do a simple search to find
the InfoExplorer articles “How to Perform a Compound Search (InfoExplorer
Windows)” and “The Compound Search Window.” The smple search is
described in this chapter in the previous section.
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Printing from the InfoExplorer graphical interface

You can print the following information from the I nfoExplorer

graphical interface:

= articles from areading window

» al artidesreferred to by a navigation window

= artwork displayed in a graphic window

= public and private notes

For detailed information on printing, follow the directionsin “Using
InfoExplorer to Learn InfoExplorer (Graphical Interface),” earlier in this

chapter, to find the section “ Printing Information (InfoExplorer Windows)
in Chapter 7 of IBM's Al X \&rsion 41 Getting Sarted.

Keys and keystroke sequences for the InfoExplorer
graphical interface

In the InfoExplorer graphical interface, you can use special keys and key
seguences to move within awindow, choose items from a menu, access
additional windows, and start processes.

For detailed information, follow the directions in “Using InfoExplorer to
Learn InfoExplorer (Graphical Interface),” earlier in this chapter, to find the
section “Using Special Keys and Key Sequences (InfoExplorer Windows)” in
Chapter 7 of IBM's Al X \ersion 41 Getting Sarted.

Stopping InfoExplorer

You can stop the InfoExplorer program from any open | nfoExplorer window.

To exit the InfoExplorer program and save all bookmarks and notes:

= Choose Quit from the “info” menu in any InfoExplorer window.

All open windows are closed and the program is exited.

To exit the InfoExplorer program without saving all bookmarks and notes:

s Choose Close from the navigation window menu located to the left of the title bar.

All open windows are closed and the program is exited.
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Customizing the InfoExplorer graphical interface

The Options menu in the navigation window allows you to reset
InfoExplorer defaults.

Choose Defaults from the Options menu (in the navigation window’s menu bar).

The Defaults Editor dialog box appears.

Info: Defaults Editor

To change the default search databases, click the button below the Default Search
Databases option; to change the default navigation article, click the button below the
Default Navigation Article option.

Click the appropriate item in the list that appears.

Click the Save button.
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Using the InfoExplorer ASCIl interface

This section introduces the I nfoExplorer program ASCI| interface Snce
InfoExplorer information is hypertext, you view the information on your
computer screen and select links to move from one article to another. Thus
you can choose your own path through the hypertext documentation.

Starting InfoExplorer in ASCIl mode
To start InfoExplorer in ASCII mode:

= Enter the command
info -a

A navigation screen appears that is, by default, the Topic & Task Index screen.
To change this default, see “ Customizing the InfoExplorer ASCII I nterface’
later in this chapter. The navigation screen displays lists of topics that contain
hypertext links to pertinent articles. The articles are displayed in areading
screen. For more information on navigation screens and reading screens, see
“InfoExplorer ASCII Screens’ later in this chapter.

Using InfoExplorer to learn InfoExplorer (ASCII interface)

This section offers a quick procedure for displaying Chapter 7, “Accessing
Information With InfoExplorer,” of IBM's Al X \ersion 41 Getting Sarted.

1 Press Control-O to activate the menu bar.

2 Usethe Left and Right Arrow keys (or press D) to highlight Display in the menu bar, then
press Return.

3 Use the Down Arrow key to highlight List of Books in the Display menu.
4 Usethe Tab key to highlight AIX 4.1 Getting Started, then press Return.
5 Usethe Tab key to highlight the section you wish to consult.

6 Press Return to display the information.
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To print the artide:
Press Control-O to activate the menu bar.
Press I to highlight “info” and press Return to display the menu.

Use the Down Arrow key to highlight Print Article, then press Return.

InfoExplorer ASCII screens

In the InfoExplorer ASCII interface, different screens contain different types
of information. For example, you use some screens specifically for moving
through the information database These screens, which include the Topic &
Task Index and the Books, are navigation screens The InfoExplorer program
displays one navigation screen at atime The contents of this screen are
replaced each time you select afunction that displays its information in this
location.

The screen that contains the text you want to read is called the reading screen.
When you do an information search, the navigation screen becomes the
reading screen. Reading screens provide conceptual, procedural, or reference
information. They display articles that teach you about a topic, explain how to
do something, or provide you with information about commands, calls,
subroutines, files, or file formats.
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The reading screen

When you start the InfoExplorer ASCII interface for the first time, the first
screen that appears is the reading screen, containing the document “Welcome
to the InfoExplorer ASCII Interface” The reading screen contains procedural,
conceptual, and reference information. The first line of the screen displays
the menu options, and the second line displays atitle bar. The phrase “info
Document” appears at the right end of the title bar.

info
T

Welcome to

Search Exit

cokmarks  Notes
II Interface
II Interface

With InfoExplorer, you can access software and hardware information in an
cnline information base consisting of articles connected by hypertext links.
2 hypertext link is a one-way path from cne piece of information to another.

Words that are underlined in InfoExplorer text are hypertext links. The
InfoEzplorer program automatically highlights the current link in reverse
video., To see more informaticn about the InfoEzxplorer program, use the Tab
key to move from link to link. When the item vou want to see is highlighted,
press the Enter key:

# Basic InfoBExplorer Scoreen Operaticns

*# New InfoExplorer Features

* Reader’s Comment Form

# Copvright and Trademark Information.

Only one reading screen is available at atime Each time you select alink to
another article the contents of the article you select replace the contents of
the original artice
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The navigation screen

The navigation screen is the starting point for finding documentation about
the operating system and other programs available on your system.
Information is organized by topic and task, by book, or alphabetically by
commands or programming reference items.

Thefirst line of the screen contains the menu bar; the second line displays a
title bar that displays the title of the screen. In the figure below, the second
line informs you that the title is Topic & Task Index and that thisis a
navigation screen.

info Help Librar Displa L Histor Bookmarks MNotes Search Exit
Topic & Task Index info Navigation

Tééic & Task Index

Managing
Programmineg
Problem Solwving

Error Message Index

Glossary
README Files

To send a comment to the documentaticon manufacturer, see InfoExplorer
Beader’s Comment.

Note: The navigation information in this section applies to the InfoExplorer
program that is shipped with your operating system. The navigation
information may or may not apply to other libraries

While you are viewing the InfoExplorer program through the ASCI| interface,
only one navigation screen is available at atime Each time you select alink
to another navigation article, the contents of the article you select replace the
contents of the original article For information on selecting links, see
“Selecting an ASCII Hypertext Link” later in this chapter.
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Moving between the screens

To return to the navigation screen from the reading screen (or to go back to
the reading screen from the navigation screen), press Control-W.

Selecting an ASCII hypertext link

Items that are underscored in navigation screens or reading screens are
hypertext links; the currently selected link is highlighted in reverse video.

To follow alink to more information:

Press the Tab key (or Control-F) to move from one link to the next.
Press Control-B to move back to the previous link.

Press the Return key to display the linked information.

Getting Help

You can display the Help menu as follows:

Press Control-O to activate the menu bar at the top of the screen.

Use the Left and Right Arrow keys (or press H) to highlight the menu title Help.

Press Return.
You can then choose between the following items:

= This Window. Displays specific help information for the screen you are
viewing, including the following:
—Ilinksto articles that describe the screen
—functions available from that screen
—allist of menus available in the screen
—Ilinks to descriptions of the menu items

You can select links to display information that you want to read. To
return to the help information screen after selecting alink, use the Path or
History menu in the menu bar. See “Returning to a Previous Location”
later in this chapter.

n List of Helps Displays alist of hypertext links to articles that describe key
aspects of the InfoExplorer program and documentation, along with links
to the individual help screens.
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Scrolling information in ASCII screens

You can move forward or backward through text displayed in either the
navigation screen or the reading screen by using the following keys and key
seguences.

Move Keystroke

Previous page Page Up key or Control-P
Next page Page Down key or Control-N
Cursor up one line Up Arrow

Cursor down one line  Down Arrow

Choosing an ASCII menu item

Each InfoExplorer screen contains a menu bar across the top of the screen. To
choose a menu item, do the following:

Press Control-O to activate the menu bar.

Use the Left and Right Arrow keys (or type the initial letter of the menu title) to highlight
the title of the menu you want to display, then press Return. Instead, you may type the
underlined character in the menu title.

The menu is displayed as a pull-down panel with several items.

Use the Up Arrow and Down Arrow keys to highlight a menu item (or type the underlined
character in the desired menu item); then press Return.
The item you choose is invoked, or another menu is displayed.

To remove a menu without choosing an item, press Control-O. The cursor
returns to the screen.

Using the InfoExplorer ASCll interface 79



Returning to a previous location

During the InfoExplorer session, the I nfoExplorer program keeps two
different records of where you have previoudy been: the History List and the
Path List. These lists enable you to return to previous locations in the
information database

History List

The History List records every location that you have displayed in the
information database during the current I nfoExplorer sesson. To view the
History List, do the following:

Activate the menu bar by pressing Control-O (if it is not already activated).

Use the Left Arrow and Right Arrow keys (or press the period key) to highlight .History,
then press Return.

The History menu is displayed.
Use the Up Arrow and Down Arrow keys to highlight the List All item, then press Return.

Use the Left Arrow and Right Arrow keys to highlight the location to which you wish
to return.

Press Control-O to activate the menu bar.

Goto in the menu bar should be highlighted. If it isn’t, highlight it, then press Return.

Path List

The Path List keeps track of your current navigation route starting with a
primary navigation screen (Topic & Task Index, Books, Commands, or
Programming Reference). Every time you return to a primary navigation
screen, your previous path list is overwritten.

The Path menu contains three options:

= Show List. Displays the path list.

= Previous Jumps to the previous location without displaying the path list.
= Next. Jumps to the next location without displaying the path list.
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To return to a previous location in the InfoExplorer program:
Activate the menu bar by pressing Control-O.

Use the Left Arrow and Right Arrow keys (or type P), then press Return to display the
Path menu.

Use the Up Arrow and Down Arrow keys (or type S), then press Return, to display the
Path List.

A pop-up box displays alist of locations in the path. If you arein a primary
navigation screen, you receive a message stating that the Path List is empty.

Use the Up Arrow and Down Arrow keys to highlight the location to which you want
to return.

Press Control-O to activate the menu bar.
Highlight Goto in the menu bar, then press Return.

The text appears in the reading screen.

Finding information via the primary navigation routes

To display the primary navigation routes in the navigation screen:
Press Control-O to activate the menu bar.

Use the Left Arrow and Right Arrow keys (or press D) to highlight Display.

Press Return to display the menu, which offers the following choices:

n Task (the Topic & Task Index). Displays information by task. Thisisthe
default navigation article

= Commands. Displays an alphabetical list of available commands

= Books Displays alist of articles arranged as though in hard-copy book
form.

» Programming Reference Displays lists of programming functionsin
alphabetical order by functional categories.
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Searching by word and phrase

If you do not know what a task or command is, or in which book the
information resides, use the search facility to search the InfoExplorer
information database

Two types of searches are available in InfoExplorer: the smple search and the
compound search.

The smple search allows you to use aword or string of characters (in exact
order) to search through text, article titles, or both. In the ASCII version of
InfoExplorer, the Article Title item on the Search menu lets you perform a
smple search of article titles

The compound search allows you to search using aword, a set of words,
or several sets of words. You can further specify the search with the
following options:

= And, Or, and But Not operators
= proximity options
= Search categories

You can also specify the information databases to be searched for both simple
and compound searches There are two ways to specify an information
database:

= You can select atemporary information database in the Compound Search
dialog box. This selection applies to both smple and compound searches
and stays in effect for the current session of InfoExplorer or until you
change the selection during the sesson.

= You can select an information database as a default by choosing Defaults
from the “info’ menu and sdlecting DBselect. This default information
database applies to both smple and compound searches, and stays in effect
for future sessions of InfoExplorer.

Temporary information database sel ections made in the Compound Search
dialog box can override the default selection during an InfoExplorer
session, but the default selection returns when you restart I nfoExplorer.
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The simple search
You can perform a simple search as follows:

Press Control-O to activate the menu bar.

Use the Left and Right Arrow keys (or press S) to highlight Search, then press Return.

Use the Up and Down Arrow keys to highlight Simple in the Search menu, then
press Return.

The Simple Search dialog box appears.

Zearch Help ouit

Find: |

Type the word or phrase you are searching for in the Find field, then press Return.

A list of articles appears.

For an on-screen tutorial about performing a simple search, follow the
directionsin “Using InfoExplorer to Learn InfoExplorer (ASCII Interface),
earlier in this chapter, to consult “ Searching for I nformation (ASCII
Interface)” in Chapter 7 of AIX \&rson 41 Getting Sarted.
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The compound search
You can perform a compound search as follows:

1 Press Control-O to activate the menu bar.

2 Usethe Left Arrow and Right Arrow keys (or press S) to highlight Search, then
press Return.

3 Usethe Up Arrow and Down Arrow keys to highlight Compound, then press Return.
The dialog box for doing a compound search appears.

Press the Tab key to move from field to field; in the highlighted fields, press
the arrow keysto display the available choices

The Find field allows you to specify three text strings and three operators
(And, Or, But Not) to relate those strings to one another in the order in which
they are displayed in the dialog box. For more information, see the
InfoExplorer article “Narrowing or Broadening a Compound Search.”

The Within field allows you to designate the proximity of the specified

text strings (within the same article; within 10, 50, or 100 words of the
same paragraph).

The Search field allows you to specify the kind of text searched (in the first
field) and where in the database to perform the search (in the second field,
following the word “in”).

4 Press Control-O to activate the menu bar.
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5

6

Choose Search to proceed with the search.

A search match list appears.

Listall Help o0Quit
*h Match List

Wlavigation: 14 matches in 3 documents

Commands Reference: 34 matches in § documents
ATIH Technical References: NO MATCHES FOUND.
AIXWindows Technical Reference: NO MATCHES FOUND.

Files Reference: NO MATCHES FOUND.

Help for SMIT: 7 matches in 6 documents
Help for InfoExplorer: NO MATCHES FOUND.
ATIH User Guides: 88 matches in 9 documents

Use the Up Arrow and Down Arrow keys to highlight the appropriate item, then press
Return. To list all hits in all sources, press Control-O to activate the menu bar; then, with
Goto highlighted, press Return.

A list of sources and the number of hitsin each source appears.

Use the Up Arrow and Down Arrow keys to highlight the appropriate item, then
press Return.

The appropriate information appears in a reading window.

For a more detailed description of the compound search, see the InfoExplorer
article “How to Perform a Compound Search (ASCII).”

Printing from the InfoExplorer ASCII interface

Follow the directions in “Using InfoExplorer to Learn InfoExplorer (ASCII
Interface),” earlier in this chapter, to consult “Printing Information (ASCII
Interface)” in Chapter 7 of AlX \ersgon 41 Getting Sarted.
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Keystrokes used in the InfoExplorer ASCII interface

Different keys and key sequences are active depending on whether you are
working in atext area, amenu bar, or a pop-up screen.

Keystrokes used in text areas

Keys Action

Control-W Toggles between the navigation screen and the reading screen
Control-F or Tab Moves to the next hypertext link

Control-B Moves to the previous hypertext link

Return or Enter Activates an operation

Control-L Refreshes the screen

Control-N or Page Down
Control-P or Page Up
Left Arrow

Right Arrow

Up Arrow

Down Arrow

<

>

Scrolls vertically to the next page

Scrolls vertically to the previous page

Moves the text cursor one character to the left
Moves the text cursor one character to the right
Moves the text cursor up one line

Moves the text cursor down one line

Moves the text cursor 20 characters to the left
Moves the text cursor 20 characters to the right

Note: The Left Arrow and Right Arrow keys do not function for the
InfoExplorer program on WY SE terminals.

Keystrokes used in menu bars

Keys

Action

Control-O
Esc-Esc or Control-O
Tab

Left Arrow

Toggles to make the menu bar active or inactive.
Closes a pull-down menu and places the cursor in the text area.

Highlights the next menu in the menu bar. In pop-up screen menu
bars, moves the cursor from the menu bar into the text area if no
pull-down menus are currently highlighted.

Highlights the previous option. If a pull-down menu is displayed, the
previous menu title is highlighted and its pull-down menu is displayed.
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Keystrokes used in menu bars (continued)

Keys Action

Right Arrow Highlights the next menu. If a pull-down menu is displayed, the next
menu title is highlighted and its pull-down menu is displayed.

Up Arrow Displays the pull-down menu for the highlighted menu title or highlights
the previous item in a pull-down menu.

Down Arrow Displays the pull-down menu for the highlighted menu title or highlights
the next item in a pull-down menu.

Return or Enter Activates the operation of the highlighted menu item.

In some cases, the menu bar within a pop-up screen contains options that
start or stop a process. The following keys can also be used to move within a
pop-up screen or to cyde through options in the screen.

Keys Action

Tab Moves to the next field

Left Arrow Moves to the previous option in a group of options

Right Arrow Moves to the next option in a group of options

Spacebar Cycles through the options in a group of options

Up Arrow Highlights the previous item in a list

Down Arrow Highlights the next item in a list

Return or Enter Activates the operation of the highlighted item, or ends text entry and

advances to the next field

Stopping the InfoExplorer ASCII program

You can |leave the InfoExplorer program from either the navigation screen or
the reading screen.

Activate the menu bar by pressing the Control-O key sequence.

Use the Left Arrow and Right Arrow keys (or press E) to highlight Exit, then press Return.
The Exit menu appears.

Choose the Confirm option by pressing Return.

The operating-system command prompt appears and the InfoExplorer
program stops.
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Customizing the InfoExplorer ASCII interface

You can change the defaults for the following items of the InfoExplorer
ASCII interface:

= navigation window article
= history, notes, and bookmark files

= printers

To change the defaults:
In the navigation window, activate the menu bar by pressing Control-O.
Use the Left Arrow and Right Arrow keys (or press i) to highlight “info,” then press Return.

Use the Up Arrow and Down Arrow keys to highlight Defaults, then press Return.

Help Library

Print article
Print References
Preferences
| Wetfaults
Copyright

Use the dialog box that is displayed to change the default navigation article,
move the cursor into the Navigation Article field, and press the arrow keys to
display the available options for the default navigation article.

To edit the printer fields, move the cursor into the appropriate Printer field
and edit the existing text.

To set the default Bookmark, History, and Notes fields, choose from thefile
lists in the Bookmarks, History, and Notes items in the menu bar of the
Defaults screen. For further information, see the InfoExplorer article “How to
Set Defaults”

From the menu bar in the Defaults screen, choose Save to save the changes; choose
Reset to delete the changes.
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The i nf o command options

You can use thei nf o command with the items listed in the table

Option

Function

-a
- di spl ay host:number
-f isofonts

-9
- h string

-hel p
- hl ¢ color
-iconic

-1 libname

-msh N

-n [ti | bl | cl
-q

- 'S term

- shc color
-t string

-tags

-t xc color

Starts InfoExplorer ASCII version.

Specifies the display host.

Specifies for text to be displayed in 1SO fonts.

Forces the window version of InfoExplorer to run on the default
display or the display specified by the - di spl ay option.
Specifies a term that is used to search for a command article or
content list for a specified topic or task.

Displays the usage message.

Specifies the color for hypertext links.

Starts InfoExplorer with the navigation window icon on the
desktop. After the icon is opened, all application windows
open normally.

Specifies which database library InfoExplorer opens.
Specifies the maximum number for search hits.

pr | [1-8] ]
Specifies the alphabetic abbreviation or the numeric value
identifying which primary navigation article is displayed.
Starts InfoExplorer quickly without displaying the copyright notice
and the InfoExplorer “Welcome” article.

Specifies a term or phrase that is immediately used in a
simple search.

Specifies the color for search hits.

Specifies a term or phrase that is immediately used in a
title search.

Sets the debug environment switch enabling the inclusion of the
Tags menu in the Preferences window menu bar.

Specifies the color for article text.
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Using System Administration Tools

This chapter describes the following tools that provide special interfaces for
handling system administration tasks:

» Visual System Management (VSM)
= System Management I nterface Tool (SMIT)




Visual System Management

Visual System Management (VSM) is a graphical interface that enables you to
perform installation and system management tasks through direct
manipulation of icons For example, you can delete a user by dragging the
User icon to the Trash Can icon. In addition to performing basic tasks, you
can create new objects from system-defined or user-defined templates; sort,
filter, and find objects; and display the objects in a variety of views.

Starting VSM applications
You can start VSM applications from the command line (see “Starting VSM
from the Command Lin€’ later in this chapter) or from CDE.

Starting VSM from CDE
Start VSM from CDE as follows:

1 From the front panel, click the Application Manager icon.

|

The Application Manager window appears.

File Zelected “iew

=

ormat ion BampleClients

m Admin  Custom

92

Chapter 6 / Using System Administration Tools



2 Double-click the System_Admin icon.

README

3 Double-click the desired application icon.
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Starting VSM from the command line

You can start the following VSM applications from the command line of a
terminal window with the commands listed.

Application name Command

Device Manager xdevi cem

Easy Install Xinstallm-ez
Install Manager xinstall m
Maintain Software xmai nt m

Print Manager Xprintm

Storage Manager xlvm

Users & Groups Manager  xuserm

The VSM interface

The features common to many VSM application windows are described in
this section.

As an example, the Storage Manager window isillustrated.

Most VSM applications contain awork area that contains panes and wells, an
areathat contains actions, and an information area. For more information
about how to work in a specific VSM application, read the help text in the
information area, or click the Help button to start the Help System.

Work area panes and wells

The work area is organized into panes contai ning icons that represent specific
related functions or objects. You can double-click some of these icons that
contain related objects to display awdl (or wells). The well displays the
related objects. Double-clicking an object that cannot be expanded brings up
a notebook (dialog box) displaying the object's attributes For information on
working with objects, refer to the help in the information area.
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Actions: Drag and
drop onto objects to
perform actions

Work area panes

Work area well:
Double-click to open

Information area

Click to collapse area

Storage Manager : root@pubsi
R> Template Area
Typ File System Templates 3 Objects

_JFS CDRFS  NFS§

Work Area

File Systems

5 Objects

= = = = =
00 10 00 10 00
/ /home  /usr Fvar Ftmp

Volume Groups 1 Objects

ﬁll ‘.
rootvg "
Vlew Controls Dlsplay Controls
Q az | 7
L oy

< Information Area

Information Area - Displays information about the object or area at the current cursor location.
To get more information about an object or area, drag and drop the ? Action on it.

Actions—dragging and dropping

Theiconsin the arealabeled “Actions’ represent various actions that you can
perform on the objects in the panes and wells of the work area. Perform these
actions by moving the mouse pointer to the action, pressing the middle mouse
button (or the Left Arrow key), and dragging the action icon to the
appropriate object on which you wish to perform the action. Thisis referred
to as dragging and dropping

VSM dialog boxes

Dialog boxes appear if the system requires additional information for
completing atask. For more information about dialog boxes, select the Help
button in a dialog box. For information about the fields and buttonsin a
dialog box, dick the question mark (?) button at the bottom of the dialog box.
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Information area

Theinformation area displays a brief description of the object or area at
which the mouse pointer is located. See the next section, “Getting Help in
VSM”

Getting help in VSM

All information about the application and how to use it is available on screen.
Use the following methods to access help in the interface

Information area

Theinformation area, which is at the bottom of the dialog box, provides
context-sensitive help based on the position of the cursor. The description
provided is often accompanied by an explanation of the task you can perform.

Dragging and dropping the Item Help (?) action icon

Use the middle mouse button (or the Left Arrow key) to drag and drop the
Item Help (?) action icon on atarget to open aHelp System window that
takes you directly to the help for that target. Use the Item Help (?) action icon
to learn more about a specific object or area. For more detailed information
about the concepts discussed in the help screens, see the AlX \erson 41
System Management Guide: Operating System and Devices

? and Help buttons in a dialog box window

The question mark (?) button in a dialog box opens a help window that
provides context-sensitive help for the highlighted field in the dialog box. The
Help button opens the Help System window displaying the help topic for
dialog boxes.

Help button in a message window

The Help button in a message window provides more information about
the message.
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VSM applications

The following sections describe how to use the available VSM applications.
Start these applications by double-clicking their iconsin the
Application_Manager—System_Admin window or by entering a command, if
available at the command line

Device Manager
Double-click the Device Manager icon (or enter xdevi cemat the command
line) to display the Device Manager dialog box.

Device Manager displays system objects and dialog boxes that repesent the
contents of your systenis Device Configuration database. This enables you to
manage some devices not covered by SMIT, such as graphic adapters, graphic
display subsystems, ports, buses, expansion drawers, non-SCSl adapters,
standard adapters, and memory cards. The Show Tree View button (at the
bottom left of the dialog box) allows you to view how the devices are
interconnected.

Device Manager does not include the following SMIT functions:

= trace devices

= printer subsystem management (including virtual printers)

= communications applications and services

» LFT devices: keyboard, displays, fonts, speakers

= Xstation configuration

Easy Install

Double-click the Easy Install icon (or enter xi nst al | m - ez at the command
line) to display the Easy Install dialog box, which allows you to install software
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Install Assistant

Double-dick the Install Assstant icon to display the Install Assistant dialog
box.

This dialog box offers an interface for performing the following tasks:

» Setting the date and time and the root passwvord

= configuring network communications

= Managing system storage, paging space, and the language environment
= Creating user accounts

= defining printers

= importing existing volume groups

= installing software applications

» backing up the system

Install Manager

Double-click the Install Manager icon (or enter xi nst al | mat the command
line) to display the Install Manager dialog box.

This dialog box allows you to perform the following tasks:

» installing and updating software products

= creating bundles

= defining installation settings

Maintain Software

Double-click the Maintain Software icon (or enter xmai nt mat the command
line) to display the Maintain I nstalled Software dialog box.

This dialog box allows you to perform the following tasks:

» commit to a software update and automatically remove all previous
versons

= reject an applied update, remove the updated files, and revert to a previous
version of the software

» Vverify the correctness of the installed software
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Print Manager
Double-click the Print Manager icon (or enter xpr i nt mat the command line)
to display the Print Manager dialog box.

This dialog box enables you to perform basic SMIT tasks on printers and
gueues and is designed to make creating queues much smpler. In addition, it
provides a graphical representation of queue and printer attachments as well
as print jobs waiting in the queue

Print Manager does not incdude the following SMIT functions:
» Starting aprint job
= scheduling jobs

Storage Manager

Double-click the Storage Manager icon (or enter x| vmat the command line)
to display the Storage Manager dialog box.

This dialog box enables you to manage physical volumes, volume groups,
logical volumes, and file systems through direct manipulation. In addition,
Storage Manager provides an easy way to view the contents of alogical volume

Users & Groups Manager

Double-click the Users & Groupsicon (or enter xuser mat the command
line) to display the Users & Groups Manager dialog box.

This dialog box simplifies adding users by providing system-defined and user-
customized templates. Smple drag-and-drop actions enable you to set user
passwords, change a user's language, and specify whether or not a user can
log in to a system.
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VSM keyboard basics

You can perform many of the mouse actions by using various key sequences,
even though the help windows always refer to mouse actions. For a
description, use InfoExplorer to consult “VSM Keyboard Basics’ in Chapter 6
of IBM’s AlX \erson 41 Getting Sarted.

For a description of InfoExplorer, see Chapter 5 of this guide For a summary
of commands for accessing Al X \erson 41 Getting Sarted, see the section
“Using InfoExplorer to Learn InfoExplorer (Graphical Interface)” or “Using
InfoExplorer to Learn InfoExplorer (ASCII Interface),” both in Chapter 5 of
this guide

IMPORTANT Set the keyboar dFocusPol i cy resourceinyour . Xdef aul ts
filetoexpl i cit sothat you can set the input focus using key sequences.
When using the keyboard, the focus area is emphasized. Generally, a focus
area can be selected or serve asadrop site

The following explains how to use key sequencesin place of a mouse:

= Point: Press Tab (forward) or Shift-Tab (backward) to move between areas
Use the arrow keys to move from object to object in an area. The focus
area is emphasized.

n Click or select: Press the Spacebar key. A selected object appears with a
white background outlined in black.

= Double-dick: Quickly press the Spacebar key twice

= Drag and drop: If the phraseis “drag and drop on atarget,” select the target
object. If the phraseis“drag and drop in an area,” select an object, then
select the target area and press the Insert key.

= Multiselect: To multiselect, select an object, then use the arrow keys to
point to another object and press Shift-Spacebar. Continue until you have
selected all the desired objectsin the area. You can select all by selecting,
Control-/ and deselect by entering Control-\.
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= Choose: Point to an object or area and press Shift-F10 to view a pop-up menul.
Use the arrow keys to move from item to item. Press the Spacebar or
Return to select the item; or you can select an item by pressing its
mnemonic (underlined character). Pressing the Esc key cancels the pop-up

menu.

The following tables contain default key sequences you can use in VSM.

Default key mappings for managing the VSM interface

Key Function

Spacebar Selects an object

Shift-Spacebar Multiselects objects

Control-/ Selects all objects

Control-\ Deselects all objects

Insert Drops a selected object in a selected area
Tab Moves the focus from area to area

Shift-Tab Moves the focus backward from area to area
Arrow keys Moves the focus from object to object in an area
F1 ? Item Help action for selected object

F2 Sort Display control for selected area

F3 Find Display control for selected area

F4 Filter Display control for selected area

F5 Large Icon View control for selected area

F6 Small Icon View control for selected area
Delete Trash action on selected object

Control-Backspace

Notebook action on selected object

Default key mappings for managing the help window

Key Function

F1 Provides help on using the help window

F10 Moves the focus back and forth between the read window and the
menu bar in the Help System window

Control-K Opens a Keyword Search window displaying a help index
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Control-B Backtracks to the previous help topic
Control-U Goes up one level in the topic hierarchy
Control-H Returns to the home topic

Default key mappings for managing the windows

Key Function

Alt-F3 Lower

Alt-F4 Close

Alt-F5 Restore

Alt-F6 Moves the input focus from window to window within the VSM application

Alt-Shift-F6 Moves the input focus to the previous window within the VSM application

Alt-F7 Move

Alt-F8 Size

Alt-F9 Minimize

Alt-F10 Maximize

Alt-Tab Raises the next window in the stack and moves the input focus to that window

Alt-Shift-Tab  Raises the previous window in the stack and moves the input focus to
that window

Alt-Esc Raises the next window in the stack without changing the input focus

Alt-Shift-Esc  Raises the previous window in the stack without changing the input focus

Using the System Management Interface Tool (SMIT)

You can use the System Management | nterface Tool (SMIT) to perform
system administration. SMIT provides a task-oriented interface to use the
commands required to manage your system. SMIT menus and dialog boxes
let you quickly create administration commands and free you from the details
of complex command syntax. SMIT also creates log files that you can use to
duplicate system configuration or |earn about specific commands.

Note: Other system management tools are available You can use the Disk
Management Utility for logical volume management or the Visual System
Management (VSM) applications.
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You can use SMIT to help start the installation process and install optional
software, as well as manage the following:

= Users and groups

= System environment, performance, and problems
= Storage and file systems

= printers, terminals, and tape drives

= print jobs and print queues

= networks

For information about SMIT, see the System Management Guide: Operating
System and Devices available through I nfoExplorer.



Setting Up AppleTalk and AppleTalk Services

This chapter describes AppleTalk and AppleTalk services and covers the
following topics:

installing AppleTalk
usng SMIT to start, stop, and query AppleTalk services
using AppleTalk in single port mode

using AppleTalk in multiport mode, including the configuring of routers,
zones, and ports

using AppleTalk commands to check AppleTalk status, start and stop
AppleTalk, and test for network nodes

configuring AppleTalk services such as the PPC daemon and Mac OS
utilities
setting your default printer and creating print queues




AppleTalk networking

AppleTalk is aset of smple and flexible network protocols that connect
computers and peripheral devices such as printers. AppleTalk over Ethernet
provides high-speed communications between computers.

Computers running AppleTalk can take advantage of the Mac OS utilities
such as the Disk Management Utility and CommandShell.

AppleTalk supports traffic on many ports concurrently. This allows you to use
multiple network interfaces (such as several Ethernet cards) at the sametime

The AppleTalk kernel stack has full routing capabilities. This means you dorit
need a dedicated router to connect machines on multiple networks

AppleTalk can run on some or al of your network ports and can runin
parallel with other protocols on the port. For example, you can use AppleTak
with TCP/IP, You can set up the protocols so they can share your network card
and cable, or you can dedicate separate cables for each protocol.

To use AppleTalk, you need to configure your system. You use the System
Management I nterface Tool (SMIT) to configure AppleTalk. If you have not
used SMIT, ssimply follow the steps in this chapter. You can learn more about
SMIT in Chapter 6 of this book.

Before you can use AppleTalk

To take advantage of AppleTalk services, you need to install the AppleTalk
software. For information about installing additional software with the Al1X
Base Operating System, see Chapter 2, “Installing AIX on Your Network
Server”

If AppleTalk isinstalled, entries for AppleTalk services will appear in the
SMIT menu for Communications, Applications, and Services.
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Setting up and managing AppleTalk

You can set up AppleTal k networking services through the System
Management | nterface Tool (SMIT).

To set up AppleTalk with SMIT:

1 Start SMIT.

To start SMIT, typesni t at the command prompt. The main SMIT
menu appears.

lanagement Interface Tool : rooct@p

Return Te:

1 Management
are Installation and haintenance
are License Management

orage Management (Physical & Lo
|— Communications Applications and Services

|— Print Spooling
Problem Determination

Cancel
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2 From the main SMIT menu, choose Communications Applications and Services.

A new menu appears that lists the services.

anagement Interface Tool ; |

3 Choose AppleTalk.

SMIT displays the AppleTalk menu.

AppleTalk
[ Start AppleT

The following sections describe each item.
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Using AppleTalk in single port mode

If you use AppleTalk in single port mode, you cannot use AppleTalk with
another network interface

To use AppleTalk in single port mode, choose the Start AppleTalk in Sngle
Port Mode item from the SMIT AppleTalk menu. The SMIT dialog box
presents two options.

Start AppleTalk in Single Port Mode

AppleTalk Metwork Interface ; List

Start Single Port AppleTalk when List |T|7

Command Reset Cancel ? Help

In this dialog box, select the interface for AppleTalk. By default, the system
selects the built-in Ethernet interface (et 0), but all compatible interfaces are
listed in this dialog box.

You can then select when you want to start AppleTalk services:
= Now

= during the next system restart

s both—now and during the next system restart

By default, the services start immediately.

If you choose to start AppleTalk right away and if several zones are available
on the network, you must choose one of the zones as your home zone

If you choose to start AppleTal k during the next system restart, or right
away and during the next system restart, a configuration file
(/fet c/ rc. net. appl et al k) is created and run during startup.
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Once you start the AppleTalk services, the system displays a message showing
the current configuration for your machine (network number and node
number, as well as the cable range of the AppleTalk network).

You can also get status information through the Query AppleTalk Services
menu in SMIT, or by using the at conf i g command with the - g option.

Using AppleTalk in multiport mode

You can configure AppleTalk to take advantage of multiple network
interfaces. To use multiple network interfaces with AppleTalk, you must set
up routing and use multiport mode

Administering an AppleTalk router

To use AppleTak in multiport mode, configure routing characteristics for the
AppleTalk network.

Providing seed information

Each AppleTalk network needs one router configured to provide seed
information. If your AppleTalk network does not have a seed router, you must
configure your Network Server to perform routing. If there is another seed
router on the network (you are connecting to an existing AppleTalk network),
you dont have to set up a seed router. The port can use the seed information
from the existing router.

An interface is seeding when it allocates a range of network numbers for one
or more zones on a network. A seed router sends an AppleTalk network's
identifying information to other routers connected to that network. Other
routers obtain network information, such as zone names, from the seed
router.

You use AppleTalk network and zone information to seed the network
interface For each port that is not connected to a router, you specify the
network and zone information. You cannot start AppleTalk services until this
information has been provided.

For more information about configuring AppleTalk networks, see “AppleTak
Networking Guide’ and the manual for the Apple Internet Router.
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Configuring AppleTalk

To configure your Network Server as arouter for AppleTalk, use SMIT. (To
get to multiport configuration in SMIT, use the path Communications and
Services/AppleTalk)

Click Configure AppleTalk for Multi-port Mode.
Click Add or Change AppleTalk Network Interface.
The Single Select List dialog box appears
Click the interface you want to use.

The Add or Change AppleTalk Network I nterface dialog box appears.

Cornrmahc

To configure AppleTalk for multiport mode, provide the following information:
= AppleTalk Network I nterface

SMIT automatically provides thisinformation in the dialog box for the
interface you are configuring.
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= Seed Port Network Range Start

If you are configuring your Network Server to be a seed port, provide the
first number in your network range If you do not want to set up your
server as a seed port (if there is another seed router on your network),
leave this field blank or specify O. If you specify a range and another seed
router exists on your network, your information must match.

If your Network Server is the only router on the network, you can use any
numbers for your network range from 1 to 65279

Each number in your network range supports up to 253 devices for
networks with more than one segment and 254 devices for one segment
networks. (See Insde AppleTalk for more information.) You need to have
enough numbers in your range to support the devices on your network.

= Seed Port Network Range End

If you are configuring your Network Server to be a seed port, provide the
last number in your network range. If you do not want to set up your server
as aseed port (if there is another seed router on your network), leave this
field blank or specify O.

If your Network Server is the only router on the network, you can use any
numbers for your network range from 1 to 65279 If another seed router
exists on your network, your information must match.

= Home Port

You must select a home port, even if it is not the seed port. Thereis no
advantage to using one port for a home port as opposed to another. You
just need to select one

The home port is the physical networking interface and the AppleTalk
zone where the AppleTalk services will be advertised.

From a client perspective, the server home port appears as the zone where
AppleTalk services such as file sharing are found in the Chooser.

Note: The home port only applies to multiport mode In single port mode,
the home port is always the port chosen for AppleTalk services.

s Home Zone Number

Specify the number of the zone (from the list created in the next item) for
the home port. You must specify this zone for a seed router.
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s Z0ONnes

Creating azone in an AppleTalk internet is a means of conceptually
grouping devices, which makes it easier for users to locate and access
network services. AppleTalk zones are created by routers and have no
physical boundary (so a zone can be used by several interfaces).

You must define at |east one AppleTalk zone for the network on each port
configured as a seed port. The zone name can be shared between several
network interfaces. The name of the zone cannot be longer than 32
characters. You can use all characters, except the colon (:), at sign (@),
sngle quote (), asterisk (*), equal sgn (=), and tilde (~), in the zone name.
Spaces are permissible

Use the List button to the right of thisfield to display existing zones for
other interfaces

AppleTalk configuration file

When you configure AppleTalk, SMIT creates a configuration file Normally,
you should not have to edit this file and you can perform all of your
configuration through SMIT. However, there are some situations when you
may need to edit this file For example, if you want to have more than fifteen
zones, you need to add them directly to the configuration file because the
SMIT dialog box only displays the first fifteen zones.

Use a standard UNIX text editor such asvi to edit the configuration file
Here is an examplefile:

#Appl eTal k Configuration file
et 1: 35200: 35350: *
:TestNet l:etl:*

The pound sign (#) in thefirst line of the file indicates a comment that the
gystem ignores. The second line defines the network interface, specifies a
range of network addresses, and the asterisk (*) indicates that this is the home
port. The third line specifies a zone for the interface, and the asterisk (*)
indicates that it is the home zone The following sections contain more
information about creating the lines for the configuration file
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A configuration fileis also provided in/ et ¢/ appl et al k. cf g. Thisfile
contains further explanation and examples.

To specify your home port in the configuration file, you add an asterisk (*) to
the end of the line

For example, the line

etl:*

specifies that the interface will be used as the home port.

After you specify the interface in the configuration file, you can specify a
network range The following line in an AppleTalk configuration file seeds
the et 0 interface (Ethernet card 0) with addresses ranging from 25 to 50:

et 0: 25: 50
For a nonseed entry, the configuration smply consists of the name of the
interface followed by a colon. The optional asterisk (*) means that the

interface will be used as the home port for AppleTalk services. The following
lines in a configuration file show entries for nonseed entries:

et O:
etl:*

There must be only one home zone, and the home port must be listed in
this entry.

Entries for the zones and interfaces can be mixed throughout the
configuration file

The format for zone definition is
:name:interface: optional asterisk

Here is an example zone for an AppleTalk configuration file:
TestNet 1:etl:*
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In the configuration file, a zone name entry must begin with acolon (:). The
first field of the configuration line is the name of the zone (no longer than 32
characters). All characters, except the colon (:), at sign (@), single quote (*),
asterisk (*), equal sign (=), and tilde (~) can be part of the zone name Spaces
are permissible

The next fields are separated from the zone name field by a colon (:) and
designate the list of (seed) interfaces using this zone name If the zone name
isto be used as the home zone, use an asterisk (*) as the last character of the
zone configuration line

Starting AppleTalk and setting multiport options

When you choose the Start AppleTalk in Multi Port Mode item from the
SMIT AppleTalk menu, you can specify the following options:

= theinterport routing mode
= therouter configuration file
= when to start the AppleTalk multiport configuration

The following sections describe each option.

Start Multi-port AppleTalk

hWexdimum Packets per Second for inter—port routing

Choose the router configuration file ]
ETP Fouting Table size ]ﬁ |T |7
ZIP Table size ; st [& [

Aulti-ports AppleTalk when ; ]ﬁ |T |7
Command Reset Cancel ? Help
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Setting the interport routing traffic option

With the interport routing mode option, you can specify the amount of traffic
allowed through the router (the traffic not going to the services published on
the home stack, such as afile server).

This option allows the network administrator to choose how the AppleTalk
kernel stack behaves—as a router or as an entity dedicated to the services on
the server, “discouraging” users to perform cross-traffic file transfers,

With this option, you specify the maximum number of packets per second
allowed to cross from one network to another. Once the system reaches the
maximum number of packets per second, the system begins to drop packets.
If you choose the default value, AppleTalk determines a reasonable number
of packets to route from one port to another. Because routing uses the
processing power of your Network Server, you may want to lower the default
value (The minimum value for thisfield is 500 packets per second.)

Note: This option does not limit the number of packets going to the home
stack.

As an example here are some possible values and their effects. (These
numbers are smply guidelines and different network configurations may have
dightly different ranges)

= A value of 750 makes interport transfers dow for users but does not use
much of the processing power of your Network Server.

= A value of 2500 allows several users to perform transfers from one port to
another, but you may notice degraded performance for other applications
on your Network Server.

= A value of 5000 ensures that most of the systems resources are available
for interport routing. With this value, routing could take up most of the
gystem resources and significantly degrade the performance of other
applications.

Note: Thereisno upper limit for the interport routing value, but avalue
above 5000 ensures that most of your system resources are available for
routing.
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3

Specifying a configuration file

This dialog box displays the router configuration file that describes the
multiport configuration (/ et ¢/ appl et al k. cf g). You cannot change the
name or location of thisfile

Specifying when to activate AppleTalk

You can also specify in this SMIT dialog box when the AppleTalk multiport
configuration takes effect. You can choose

= NOW
» during the next system restart and consequent system starts
» both—right away and for all the future system restarts

Note: If you have changes that take effect during a system restart, the system
creates afile (rc. net . appl et al k) and overwrites any previous AppleTalk
configuration that may have been selected.

Removing an AppleTalk network interface

You can remove an interface from your system if you are no longer using it.
When you delete an interface, you also delete the zones that are specific to
the interface

To remove a network interface from your AppleTalk configuration:

Choose the Delete AppleTalk Network Interface item from the SMIT Configure AppleTalk
for Multi-port Mode menu.

A Delete AppleTalk Interface dialog box appears
Specify the interface to delete.
You can use the List button to display the available interfaces

Click Done.
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Stopping AppleTalk

To shut down AppleTalk, choose the Stop AppleTalk item from the SMIT
AppleTalk menu. When you choose the Stop AppleTalk item, the following
dialog box appears.

You can stop AppleTalk only if there arent any processes using AppleTalk
services If you try to stop AppleTalk while one or several processes are using
AppleTak (like afile server), the system displays alist of the processes

using AppleTalk, and AppleTalk is not stopped.

You need to manually terminate each process by stopping the application or
daemon using AppleTalk. When you have terminated the processes that are
using AppleTalk, you can shut down AppleTalk services

In this SMIT dialog box, you can then select when you want to stop
AppleTak services:

= now (by default)
= during the next system restart
= both—right away and during the next system restart

If you choose to stop AppleTalk the next time the server starts, the
file used to start AppleTalk automatically during startup is deleted
(/etc/rc.net. appl et al k). Thethird option shuts down AppleTalk
right away (if there arenit any processes using AppleTalk services) and
erases any startup settings for AppleTalk so that AppleTalk does not
automatically start during the next system restart.
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Querying AppleTalk status

To view the current status of AppleTalk services, choose the Query AppleTalk
Status item from the SMIT AppleTalk menu.

This menu item queries the AppleTalk services and returns the current status.
AppleTalk services can be stopped or started. If AppleTalk is active, SMIT
displays aline of information for each interface currently configured. The
line of information contains the name of the interface, the state of the
interface (most likely “Onling’), and network information including the
network range, the AppleTalk address for the interface (made of the network
and node numbers), and the logical AppleTalk port number.

An asterisk (*) in front of aline means that this port is the home port.

The following is an example of the result of a query about a four-port
configuration. Note that interface et 2 is the home port.

-------- Appl eTal k Statistics -----------

Net wor k
I/F State Range Node port
etl Online 35281- 35281 35281: 88 1
*et2 Online 35282- 35282 35282: 149 0
et3 Online 35283- 35283 35283: 210 2
et4 Online 35284- 35285 35284: 15 3
The foll owi ng processes are using Appl eTal k Servi ces:
1864
10586
1349

When application programs or services are currently registered on the
AppleTalk stack, alist of the UNIX Process ldentifiers (PID) of those
servicesis displayed.
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Using AppleTalk commands

AppleTalk provides many commands to help you gain information
about AppleTalk services This section describes the most common uses of
three commands. The commands are fully described in the manual pages.

The AppleTalk commands are located in the / usr / sbhi n directory.

Querying and stopping AppleTalk with the at conf i g command

You can use the at conf i g command with the - g option to determine the
current status of AppleTalk. If the AppleTalk kernel stack is active, the
command

atconfig -q

returns information including the current node I D, network number, bridge
address, and related information.

If no AppleTalk services are running but the AppleTalk kernel stack is still
configured, you can shut down the AppleTalk kernel stack by running the
following command:

atconfig -u

This command requires root access and should be used with caution. If any
AppleTak services are still in use, the command returns alist of the process
identifiers of the UNIX processes currently using AppleTalk. You carit stop
AppleTalk until you stop those process.

When the shutdown is complete, you may run at confi g - q to ensure that
AppleTalk is no longer running.
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Using at | ookup to list the NVES in a zone

Theat | ookup command returns alist of all NV Es (network visible entities)
in agiven zone The syntax for this command is

at | ookup <aobject>: <type>@zone>

where type is, for example, a printer or server type, object is typically the host
name or other object name, and zone is the AppleTalk network zone An equal
sign (=) istreated as awild card in the <object> and <type> fields, and an
asterisk (*) represents the current zone.

For example, at | ookup “=: Laser Witer @” would return all LaserWriters
registered in the current zone

Using appl epi ng to ensure that a node is active

You can use the appl epi ng command to ensure that a given node is active
The appl epi ng command uses the AppleTalk Echo Protocol. The format for
this command is

appl epi ng <name>: <type>[ @zone>] [ packet-sze] npackets] |

The name: type@zone parameter specifies the host computer by its name,
type and zone If you do not specify avalue for zong appl epi ng usesthe local
zone The npackets parameter specifies how many packets to send before
terminating, and packet-size specifies the size of each packet in bytes The
value of packet-sze must be between 14 and 599; by default, its value is 64
bytes.

The appl epi ng command reports whether a reply was received. The

appl epi ng command continues to send packets and to display the result
until the number of packets specified or until you issue the interrupt character
(usually by pressing Control-C). Before exiting, appl epi ng displays a
summary of statistics.
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Configuring AppleTalk services

The AppleTalk Servicesitem in the SMIT Communication and Services menu
lets you configure the Program-to-Program Communication (PPC) daemon
and lets you set up AppleTalk printing.

Setting up and starting the PPC daemon

The PPC daemon supports applications such as the Disk Management Utility
and CommandsShell and manages the exchange of AppleTalk communications
between Mac OS utilities and your Network Server.

You can use the Program-to-Program Communication option in the SMIT
AppleTalk Services menu to start, stop, and customize the PPC daemon. You
can also use this option to add to the server new daemons that you have
created for Mac OS utilities.

To use Mac OS utilities, you must start the PPC daemon. To start the
PPC daemon:
1 Click “Start the ‘ppcd’ daemon.”

This option appears in the Program-to-Program Communication menu
available from the AppleTalk Services menu.

A dialog box appears.
2 Specify when you want to start the daemon.

You can start the daemon now, at the next system restart, or both.
3 Provide a hostname for your computer.
4 Click OK.

The daemon starts

In addition to starting the PPC daemon, the PPC daemon selection under the
AppleTalk Services item contains the following options:

= Stop the ‘ppcd Daemon
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» Listal ‘ppcd Services

This option displays all the daemons on the server used for Mac OS
utilities such as the Disk Management Utility, the Status Demo AppleTalk
Services application, and CommandShell. If you have added any additional
daemons, they will also be displayed.

s Adda‘ppcd Service

This option lets you add a new daemon for a Macintosh utility to your
system. When you choose this option, a dialog box appears that lets you
specify information for the daemon.

* Mame aof New Servi

* User D

* Group 1D

* Path to Diaemon Executable
* Daemon Signature

 Guest Connections Without Passwor

Command Reset Cancel ? Help

To add a PPC daemon service, you need to specify:

—Name of the service Specify the name of the PPC component as you
want it to appear in the PPCBrowser dialog box for the Mac OS client.
Do not use spaces in the name

—User ID. Provide a user name or user ID. This value determines the
privileges the application has when it runs.

—Group ID. Provide a group name or group ID. This value determines the
privileges the application has when it runs.

—Path of the daemon executable Provide the full path to the server
component (daemon).
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—Daemon signature. The signature is a unique four-letter code that
identifies the daemon. Mac OS clients use the signature to filter Mac OS
utilities and search for specific types of applications

—Guest access. The guest field is optional. If you select guest access, any
client can connect to the application as the guest user (an actual
account). If you choose not to have guest access, the user must supply a
valid account (user name) and password to start the Mac OS utility.

—Privileged users. If you want specific users to be able the run an
application with extra privileges (such as root privileges), provide their
namesin thisfield. If auser islisted in thisfield, the user ID and group
ID values are not used.

» Change/Show Characteristics of a‘ppcd Service

After you select this option, select a service (daemon) to examine The
same options appear as those for the Add a ‘ppcd Service option. You can
change any of them or just examine them.

= Remove a‘ppcd Daemon
Deletes an entry for a daemon from the PPC daemon configuration file

Setting up AppleTalk printing capabilities

To use AppleTalk for printing, you need to set a default printer and set up a

print queue to allow print spooling. To do so, choose the AppleTalk Services
item from the Communication and Services menu and choose the Configure
AppleTalk Printing item. This item lets you select an AppleTalk printer and

view printer status.

You can use the Selecting an AppleTalk Printer item to specify your printer.
Before you can specify a printer, you need to start AppleTalk in either single
port or multiport mode
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To select an AppleTalk printer:

Choose Select an AppleTalk Printer.
A dialog box appears.

Command

Specify your AppleTalk zone.
You can use the List button to see the available zones.

Click OK.
A list of available printersin that zone appear.

Select the printer you want.
Your printer is now selected as your default AppleTalk printer.

When you select an AppleTalk printer, the system creates a print queue
named DEF_ATALK_PR_Q. If aprint queue did not previoudy exist, the
DEF_ATALK_PR_Qis set to your system-wide default print qgueue You
can also set the system-wide default queue through SMIT with the Print
Spooling option.

Once you have selected an AppleTalk printer, you can print usng UNIX
commands such as| pr, enscri pt, and pr. If you do not specify a print
gueue with UNIX commands, the print job is sent to the default print queue
You can use command-line options to specify your print queue For example,
thel pr, enscri pt, and pr commands can be used with the - P queue
option, which lets you specify the print queue

If you want to configure several printers and print queues, refer to the
on-screen documentation in InfoExplorer for printers and printing.
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Managing File Storage With
the Disk Management Utility

Managing logical volumesin AlX is complex. To smplify this process, Apple
Computer provides the Disk Management Utility. The Disk Management
Utility graphically represents the relationships between physical volumes,
volume groups, logical volumes, and file systems and lets you make changes
by dragging icons and using dialog boxes.

This chapter describes how to set up and use the Disk Management Utility
application to perform logical volume management.

The topics covered in this chapter include:

understanding logical volume management

understanding the Disk Management Utility

setting up the Disk Management Utility

starting the Disk Management Utility

using the overview window

configuring physical volumes, logical volumes, and file systems
exiting the Disk Management Utility




Overview of logical volume storage

Logical volume storage provides a transparent method of dividing and
allocating storage space on the systemis disks The set of operating-system
commands, library subroutines, and other tools that allow you to establish and
control logical volume storage is called the Logical Volume Manager (LVM).
The Disk Management Utility lets you utilize the LVM through the
Macintosh interface on remote Mac OS dients.

Using the LVM, you may combine several physical disks (physical volumes)
into a single volume group, which acts like a single large disk. The volume
group can then be partitioned into individual logical volumes. Individual
logical volumes can be allocated across multiple physical disks

At the base of the logical volume storage system lies the hard disk drive, or
disk. To be used by the operating system, the storage space on a disk must go
through a process of configuration. This section describes that process

For more information about logical volume management, see “Logical
Volumes’ in the System Management Guide: Operating System and Devices
available through I nfoExplorer.

Physical volumes

First, the disk must become a physical volume A physical volumeis a disk
connected to the computer system with certain configuration and
identification information. A disk must be designated as a physical volume
and put into an available state before it can be assgned a volume group.

The first time you start up the system after connecting a new disk, the
operating system detects the disk and examinesiit to seeif it has a unique
physical volume identifier (PVID) in its boot record. If it does, the driveis
designated as a physical volume with a physical volume name (typically

hdi skx where x is a system-wide unique number). The unique physical
volume identifier for a physical volume remains with the associated disk even
if the disk is moved to another physical location on the system.
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\Volume groups

The disk as physical volume must now become part of a volume group. A
volume group is a collection of 1 to 32 physical volumes, possibly of varying
size and type When you install AlX, you automatically create the root
volume group (r oot vg).

You create additional volume groups with the New Volume Group command
in the Configuration menu in the Disk Management Utility. Other commands
from the Configuration menu let you configure and remove volume groups.

Small systems may require only one volume group to contain all the physical
volumes attached to the system. On larger systems, the use of multiple volume
groups adds storage flexibility. You can create volume groups to separate
groups of disks for security, maintenance, or performance reasons.

You can migrate data from one physical volume to another physical volumein
the same volume group. This allows you to free the physical volume so it can
be removed from the volume group.

Disks that are not considered physical volumes (disks without physical volume
identifiers) cannot be added to volume groups. Some examples of devices that
cannot be physical volumes include floppy disks, CD-ROM discs, and all
types of network-attached devices.

Logical volumes

After you create a volume group, you can create logical volumes within that
volume group. A logical volume is a collection of logical partitions that are
grouped as a single storage entity. Logical volumes can be used for storage or
as the base for afile system. (Logical partitions and file systems are discussed
in the following sections)
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When you install the operating system, you automatically create one volume
group (the root volume group) consisting of a base set of logical volumes
required to start the system plus any other volume groups you specify. The
root volume group contains such things as paging space, the journal log, boot
data, and root file system, each in its own separate logical volume

The maximum number of user-defined logical volumes per volume group is
255 but the actual limit is determined by the total size of the combined
physical volumes assigned to the volume group.

Logical volumes can also be copied, removed, and have the number of copies
they maintain increased or decreased (mirrored copies). They can also be
relocated through a reorganization of their volume groups. However, there are
some restrictions concerning the use of copied logical volumes. For example,
a primary dump device cannot be a copied logical volume Any dumps
attempted to a copied logical volume will fail, and no error message will be

displayed.

When you create alogical volume, you can choose to create a striped logical
volume A striped logical volume evenly allocates data on each disk that you
specify. For example if you had three hard disks to use for a striped file
system, each hard disk would have the same number of blocks of data. When
you create a striped logical volume, you need to ensure that the size of the
logical volume is evenly divisible by the partition size to ensure that the data
can be stored equally. You need more than one hard disk to create a striped
file system.

Logical partitions

When you create alogical volume, you specify the number of logical
partitions for the logical volume A logical partition is one, two, or three
physical partitions, depending on the number of copies you specify for the
logical volume Specifying one copy means there is only the original copy of
the logical volume Therefore, if you specify only one copy of the logical
volume, there is a direct mapping of logical partitions to physical partitions.
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Mirroring

The ahility to specify more than one copy of the logical volume data through
logical partitionsis called mirroring. Mirroring decreases data access time by
allowing the LVM to choose which copy (physical partition) of the data can
be accessed first. Mirroring increases data availability and helps you recover
data after a system error.

File systems

The final step in the evolution of adisk is the creation of file systems. You
can create one file system per logical volume

The advantages of logical storage

As described in the previous sections, the LVM controls disk resources by
mapping data between logical and physical storage This section explains
some aspects of logical volume storage that may not be readily apparent from
the previous discussion.

To put it smply, physical storage specifies where the data resides on the disk
itself. Logical storage controls what data is presented to the user. Datain afile
system appears to be contiguous to the user, but can be located on disk
partitions that are not side by side (contiguous) on the disk and might not be
on the same disk. Logical storage makes it easy to expand the file system as
needed and to make copies of it on other disks to protect against disk failure
These features provide you with increased availability of data and flexible
management of the disk subsystem.

Logical storage is mapped to physical storage when the LVM references data
represented in the logical partition. The datais stored in either one, two, or
three physical partitions. A logical volume can span physical volumes because
it is composed of logical partitions allocated onto physical partitions within
the volume group.
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Any available physical volume attached to the system can be grouped into a
volume group. The user sees each volume group as a set of one or more
logical volumes. The operating system uses separate logical volumes for
specific purposes, such as page space, file systems, journal log, boot data, or
dump storage.

Because alogical volumeisjust a collection of one or more physical
partitions within a volume group, the location, number of copies, and size of
the logical volume can be easily changed after the logical volume is created.

Through mirroring, you can keep copies of the user data and file-system
superblock data on different physical volumes (optionally on a different
adapter), providing up-to-the-last-second protection against hardware failure

Note: While mirroring improves storage system availability, it is not intended
as a substitute for conventional tape backup arrangements

Overview of the Disk Management Utility

The Disk Management Utility provides access to storage management on
systems running the Al X operating system. Users manage disk storage
through menus and by clicking and dragging icons that correspond to storage
objects on an Al X server. The Disk Management Utility lets you

= configure group, ungroup, and format physical volumes

» Create rename, and remove volume groups

» Create rename, and remove logical volumes and file systems

The Disk Management Utility consists of a Mac OS application and an

AlX daemon process. The two components communicate by exchanging
Apple events

You start the Disk Management Utility by starting the Disk Management
Utility Macintosh component from the Finder of a remote Mac OS client.
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Setting up the Disk Management Utility
Follow these steps to set up the Disk Management Utility.

1 Install and activate AppleTalk on the server.

For information about setting up AppleTalk, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services”

2  Start the PPC daemon on the server.

For information about starting the PPC daemon, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services”

3 Runthe AppleTalk services program on the remote Mac OS client and ensure you install
the Disk Management Utility and Network Server Passwd Tool.
Use the Mac OS Utilities for the Network Server With Al X disk provided with
AlX toinstall the Disk Management Utility. For complete installation
instructions, see “Installing Mac OS Utilities on a Mac OS Client” in Chapter
2, “Installing AIX on Your Network Server.”

4 Ensure that you have an account on the server.
You can log on as Guest if you do not have an account, but you cannot make
changes to the file system structure

Once you have satisfied these requirements, you are ready to use the Disk
Management Utility.
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Starting the Disk Management Utility
To start the Disk Management Utility:

1 Ontheremote Mac OS client, double-click the Disk Management Utility icon.

Q

Ciizk Managernent Uility

The“Select a UNIX server” dialog box appears.

Select a Unix server.
Macintoshes Servers
Disk Management Utility i

Server 1
Server 2
Server 3

AppleTalk Zones

Sales
Marketing
Engineering
Support

=
]

[ cancel | | ok

2 Select connection options.

In the AppleTalk Zones box, click the zone of the server you want. If you do
not have zones configured for your network, the dialog box does not have an
AppleTalk Zones box and you do not need to specify a zone

In the Macintoshes box, click the name of the server that you want to connect
to.

In the Servers box, click Disk Management Utility.
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3 Click OK.

A user authorization dialog box appears

P

Link to “Disk Management Utility” on
“Server1” as:

) Guest

@ Registered User

Name: | root |

Password: I:I

4 Type your user name and password.

To manipulate file systems, you must log in as the root user or be specified as
aprivileged user in the PPCD configuration file (see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services’ for more information).

If you do not log in as root or a privileged user, you can only view the
structure of your file system management.

You can select the Guest button to log in to the server with read-only access.
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5 Click OK.

The Disk Management Utility overview window appears and displays your
physical volumes, volume groups, and file systems.

EDE Server 1 EEE
Select View:[~2
e 5
Physical Yolurnes Volumne Groups Logical Yolumes /File Sustems
) hdiska 1908 ME ks
& hdiski 4296 MB & togwoz SME
}@datavg SZ20ME {

0 hdiskz 1024 ME = rdataz -

- & tegon 4ME
G hdisk3 404MB — = losatva 404re L B focal 401 MB

L & e BME

- By BME

L B home 4ME

LB fusr S20ME

L B smp 12ME
) hdiskn 2148ME — = rootg 2142ME |

I & has 4ME

L 5 hae a2ME

L B3 has 4ME

L @ fvar 4ME o
=l |

Using the overview window

When you start the Disk Management Utility, you see an overview window
that displays an overview of physical volumes, volume groups, and file
gystems for your system.

Unassigned physical volumes in this overview window may be manipulated
directly by dicking and dragging them with the mouse You can also use
menu commands to perform many tasks. By manipulating objects in this
window, you can change the réelationships of physical volumes, volume
groups, and file systems. For example, you can add an unassigned physical
volume to a volume group. You select a physical volume icon and, while
holding the mouse button down, drag it to any of the volume group or file
gystem icons. Dragging a physical volume onto a volume group icon adds that
physical volume to the volume group.
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I'n the overview window, you can choose to view specific types of
components. You can dick the buttons in the upper-right corner of the
window to change the contents of the overview window to view physical

volumes, volume groups, and logical volumes.

Note: You can only drag physical volume icons in the overview window.

When viewing only physical volumes, volume groups, and logical volumes,
you must use menu commands to perform actions

Working with physical volumes

You can view physical volumes in the overview window, or you can click the

physical volume view icon and see alist of physical volumes, asin the
following example

=

Server 1

“MWIEII

Physical Yolumes

Size

SC51 Controller /10

LUN

Available / dllocatable

Wolurme Group

& hdisk
& hdizki
& hdiskz

& hdiskd

2142ME
4296 ME
1024 e

404 ME
1202 Me

141
142
143
zi6
0/

L= = T e R R o |

YesdYez
YesdYes
YesdYez
YesdYes

Mo /Mo

rootvg

datawyg
datawg

Tocalvg

Unazssigned G

<]

EE|

I'n this view, you can double-click a physical volume icon to display a
configuration dialog box, but you cannot drag icons as you can in the

overview window.
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Configuring physical volumes
To configure a physical volume:
= Double-click the physical volume icon in the overview window.

A Physical Volume dialog box appears

=

Server1 : Physical Dolume =

Size (MB): 404

= scsID: &
SCS1 Controller: 2

hdisk® LUN: o

[ Format ] [ Migrate... |

E Available for use

E Allow allocation of additional partitions

You can also open this dialog box by selecting a physical volumeicon in the
overview window and choosing Configure from the Configuration menu.

Use this dialog box to make the physical volume available or unavailable for
use by the system, allow or disallow allocation of partitions from this physical
volume, and perform alow-level format of the physical volume

Note: Only unassigned physical volumes can be formatted. If you select an
assigned physical volume, the Format button is unavailable

You can use the Migrate button in this dialog box to transfer data to other
disks in the same volume group. You need to migrate data to clear a disk
before you can remove it from a volume group.

By default, physical volumes are available for use, and allocation of partitions
is allowed. You rarely need to change these defaults. However, there are
occasions when you may need to. For example, when removing a physical
volume from a volume group that isin use by the system, you first need to
disallow allocation of partitions from that physical volume Next, you would
migrate all data from the physical volume and then you would remove the
physical volume from the volume group.
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On arare occasion, you might need to perform alow-level format on an
unassigned physical volume This could be required because you want to
“wipe clean’ all datafrom the disk, or perhaps the disk has developed
guestionable data blocks and you want to use the format process to find the
bad blocks and remap them. In any case, if you choose the Format button, the
following alert box appears.

Forrnatting will erase the dick at SCS1I0 "3~ LUN 0",
on SCS1 Controller “0*. Do you really want to format this

device ¥

Cancel | [1].4 |

This aert box indicates the name of the physical volume as well asthe
SCSl device and bus identification numbers. Click Format to confirm this
operation. If you click Cancel, you return to the original window without
making any changes.

Grouping physical volumes

In the overview window, you can drag a physical volume icon onto a volume
group icon to add it to the group, and you can drag a physical volume onto a
file system icon to add the physical volume to the volume group of the file
system. If you drag a physical volume to the volume group, the additional
space it brings to the volume group is allocated as free space on the volume
group. If you drag a physical volume to afile system, the additional space it
bringsis allocated to the file system, increasing its size by that amount.
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Working with volume groups

You can view volume groups in the overview window, or you can dick
the volume group view icon and see alist of volume groups, asin the
following example

f &= Server | === 1=
Select Vlew_ EI
Marme Size Kind Type Status
[> 5 datawg S320ME Wolure Group - active ﬁ
= 5 localvg 404 ME Wolure Group - active
2 hdisk3 404 ME Phyzis available - allocatable
B TogT00 4MB Logizal Yolurme jfslog RFead-%rite
@ focal 401 MB File Systern jf= rounted Read-write
@ fFTR 2B File System jf= rnounted Read-Only
[> 5 rootvg 2142ME Wolure Group - active —1
&
] [o]&

I'n this view, you can double-click a volume group icon to display a
configuration dialog box, but you cannot drag icons as you can in the
overview window. Each volume group icon is preceded by atriangle If you
click the right-pointing triangle, it rotates downward, and the physical and
logical volume elements associated with the volume group are displayed.

Creating new volume groups

Use the New Volume Group command in the Configuration menu to create
new volume groups. To use this command, you must be connected to a
Network Server and have unassigned physical volumes. When you use this
command, a dialog box similar to this one appears
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EN New Uolume Group

I|I Name : (untitled

Use Physical Yolumes
hdisk4 ||

i
Physical Partition Size (ME)[ 1~ |

E Activate After Creation

E Activate at System Restart

For each volume group you create, you must provide a name. You can also

specify the size of the physical partitions, when to make the volume group
active, and the disks to use

Configuring a volume group
To configure a volume group:

Double-click the volume group icon in the overview window.

A Volume Group dialog box appears.

EN} Server 1: Uolume Group ==
Size (MB): 5320
5‘ Free: 1400
Minimum Partition Size: 2
datawg

E Auto-activate during system startup

Yolume Group Activation
Activate now {waryon)
D Deactivate now (varyoff)

You can also open this dialog box by selecting a volume group icon in the
overview window and choosi ng Configure from the Configuration menu.
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Use this dialog box to set the volume group for activation each time the
system starts, activate the volume group, deactivate the volume group, and
reorganize the volume group.

When you activate a volume group, you make it usable by the operating
system, and when you deactivate a volume group, you make that volume
group unusable by the operating system.

VVolume group reorganization relocates logical volumes and their data on
the volume group. Thisis done by changing the desired location on the
volume group that a logical volume occupies.

You usually change the position of alogical volume before reorganizing the
volume group. This type of change is done in the dialog boxes that
correspond to logical volumes and file systems (see the next section “Working
With File Systems and Logical Volumes').

For reorganization, you select one of three location values: center, middle,

and edge These locations specify where the logical volume will reside on the
hard disk—near the center, midway between the center and the edge, or near
the edge of the disk. Volumes near the center of the disk can be accessed
faster. Large and heavily used file systems, such as/, / usr, and/ hone are
candidates for center. Small and seldom-used logical volumes that contain file
gystems like boot and sysdunp are good candidates for edge Set logical
volumes with file systems of moderate size and activity to middle

Additionally, aflag for each logical volume indicates if the logical volume can
be relocated. This flag must be set in order for volume group reorganization
to have any effect on that logical volume
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When you dlick Reorganize, an alert box appears.

Do you really want to reorganize the “datavg® volume
group?

Cancel | 0K |

Click Cancel to stop the reorganization process without changing the volume
group or any of itslogical volumes Click OK to start the reorganization
process. The reorganization process can take a long time and cannot be
stopped once it begins

Working with file systems and logical volumes

You can view file systems and logical volumes in the overview window, or
you can dick the view icon for file systems and logical volumes and see alist
of file systems and logical volumes, as in the following example

S I==——————— Server | ==————— 1=
Select Vlew. E

Logical Molumes  Total Size  Copies  Type  Mount Paoint Size/Free File Systern Status

8 ToghvO0 4MB 1 jfslog - - Read=-"write

8 Toglv02 aMB 1 jfslog - - Read-*write

8 fdataz - 1 jfs AdataZ - unmounted

@ focal 401 ME 1 jfs flacal 401 /228MB mounted Read-'write

@ fFTR SME 1 jfs fFTF =/5ME mounted Read-0nly

@ ! SME 1 jfs ! S/3ME mounted Read-"rite

@ fharne 4ME 1 jfs Aharmne 4/ZME mounted Read-Ywrite

@ fusr 520ME 1 jfs fusr 520/15ME mounted Read-"rite

@ ftrop 12ME 1 jfs Arp 1211ME mounted Read-Ywrite

8 hdS 4MB 1  boot - - Read-*write

8 hd& Az2ME 1 paging - - Read=-"write

8 hd= 4MB 1 jfslog - - Read-*write

@ Fvar 4ME 1 jfs Avar 4/2ME mounted Read-Ywrite
5]
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I'n this view, you can double-click icons for file systems and logical volumes
to display a configuration dialog box, but you cannot drag icons as you canin
the overview window.

In the Disk Management Utility overview window, logical volumes have the
following types of icons and information.

Logical volume Size Meaning

E loglv00 4MB  The logical volume is without an associated file system. The
size of the logical volume appears after the icon. On systems
with a color display, the top of this icon is gray.

% fFTP 8MB  The logical volume has a mounted file system. The size of
the file system appears after this icon. On systems with a
color display, the top of this icon is green.

E fdataZ . The logical volume is associated with a file system that is not
mounted. On systems with a color display, the top of this
icon is orange.

Creating new file systems

Use the New File System command in the Configuration menu to create new
file systems. To use this command, you must be connected to a Network
Server and you must select a volume group for the file system. When you use
this command, Disk Management Utility displays a New File System dialog
box.

For each file system you create, you must specify a volume group, a mount
point, asize, and atype The type can be any of the following:
» JFS Journaled File System, the standard file system for Al X.

» Raw. Usethistype of logical volume for application-specific file systems
such as databases

= Paging. Thistype of logical volume frees memory by rotating tasks
in memory.

= Boot. Thisisaspecial type of logical volume used for starting the
Network Server.

= Sysdump. Thistype of logical volume is used to store data during a
gystem failure
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EO0=—= New File System

Ej Yolume Group:
Mount Point:l.-"untiﬂed |
Size (MB) {5 |(1400ME Available)

—ifs Settings
Fragment Size:
Bytes per Inode:
|:| Automatic Data Compression
E Auto-Mount at System Startup

E Mount Now

r—S5triping Policy

E Striped Use Physical Yolumes
ripe sk [

Stripe Size: hdisk2

=]

» JFSog. Each volume group has one JFSog file system. Thislogical volume
tracks system actions This logical volume is created automatically when
you create the first JFS file system on a volume group.

You may also specify settings for the JFS file system such as fragment size
and bytes per inode The fragment size is the smallest unit of disk space that
can be allocated to afile If your file system wort change often, use a smaller
fragment size for more efficient storage. If you have an active file system, use
alarger number so afile can be stored all in one area of memory. You also
need to determine the bytes per inode This number can limit the size of your
file system. If you choose alarge number, you reduce the number of inodes
available If you use all of your inodes, you may not be able to use all of your
disk space

You can also use the New File System dialog box to create a striped logical
volume or file system. A striped logical volume evenly allocates across
several hard disks. If you choose to create a striped file system, you need to
ensure that the size of the file system is evenly divisible by the number of
disks and the physical partition size so each disk can have the same amount of
data. For a striped file system, you also need to have more than one physical
volume in the volume group.
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Configuring logical volumes and file systems

To configure alogical volume:

= Double-click alogical volume icon in the overview window.

If the logical volume has a file system associated with it, a dialog box smilar
to this one appears.

EN Server 1: File system
@ Logical Partition Size (MB): e Fragment Size: 512
File System Size (MB): 4 Bytes Per Inode:  40%

Thome Free Space (MB):

z Data Compression: o

Log Yolume: /dev/hd2

Yolume Group: rootvg

Default Mount Point: | /homne

E Auto-Mount at system startup

e Mirroring
Copies:

Increase Size by (HB):IC'

i Default Permissions
| (@ Read/write i

i) ) Read-Only
Fragrmentation...
Advanced Settings...

You can also open this dialog box by selecting alogical volumeicon in the
overview window and choosing Configure from the Configuration menu.

You can use this dialog box to

examine information about the logical volume, such as size, amount of free
space, name of volume group, and size of logical partitions

change the mount point of the file system

increase the size of the file system (in multiples of the physical partition size)

set the file system to be automatically mounted at system startup

set read and write permissions for the file system

set mirroring characteristics for the file system

display adialog box to configure attributes for logical volumes (by clicking
the Advanced Settings button)

When you have made your selections, click OK.
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If you dick the Advanced Settings button or if you double-click alogical
volume that does not have afile system associated with it, the following

dialog box appears.
EN} Server 1: Logical Dolume
Yolume Group :Footvy Striped: Mo
@ Logical Yolume Size (MB): 4
Shorne Logical Partition Size (ME): 4

1 General Attributes v |

Logical Yolume Name : hd1

Logical Yolume Label: |.-"home

Legical Yolume Type:| ifs il

- Inerease Size

Maximum Number of Logical Partitions:

{ Position on Physical Vokmmes:
Range of Physical Yolumes:

Maximum Number of Physical Volumes:D

ENumber of Additional Logical

Use Physical Yolumes

hdisk0
hdisk1
hdisk2
hdisk3

E Enable Bad Block Relocation
[ Enable Write Yerify

E Relocate Logical Yolume During Reorganization

Permissions -
(@) Read/¥Write
D Read-Only

This dialog box contains information about the logical volume and many

configuration options.

For the configuration section, you can choose from the pop-up menu either
General Attributes or Allocation Policy to change the related settings The
dialog box displays the General Attributes settings.
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When you choose Allocation Policy, the dialog box looks like this

EJ=—=— Server 1: Logical Volume
@ Yolume Group:rootvg Striped: No
Logical Yolume Size (MB): 4
Aharne Logical Partition Size (MBE): 4

i Allocation Policy ¥ |

- Mirrering

Use physical volumes
Coptes: ko

Scheduling Policy - hdisk 1
hdiskZ
[ Mirror Write Consistency Checks hdisk3
hdisk?

[

<l

@ Copies on Separate Physical Yolumes

Position on Physical Yolumes:
Range of Physical Yolumes -
MHaximum Number of Physical ‘nl'o'lumes

You may then configure the attributes of the logical volume that pertain to the
alocation policies

By default, logical volumes are not mirrored, so the operating system keeps
one copy of the logical volume on the disk. You can change this setting so that
the operating system keeps two or three copies of the logical volume on disk.
If copies span physical volumes, you can specify that copy updates be donein
parallel or sequentially. You can also specify that whenever multiple copies
are being kept, the operating system must perform write consistency checks
and keep each copy on a separate volume. You can also specify the physical
volumes that the logical volume should mirror.

General allocation attributes of the logical volume the user may alter include
= Where the logical volume should reside on each physical volume

= Whether the operating system should perform allocations across the
minimum or maximum number of physical volumes possible

» the maximum number of physical volumes the operating system should use
when allocating space for the logical volume

When you have made your changes, click OK.
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Remote Access With CommandShell

This chapter describes how to use CommandShell to interact with AlX.

The CommandShell application lets you log in to AIX from a Mac OS client
over an AppleTak network. CommandShell provides a V T100-compatible
terminal emulation environment to run A1X commands With
CommandShell, you can open more than one window to run commands.

This chapter describes how to set up and use the CommandShell application
to perform remote system administration using a command line and
traditional UNIX commands

The topics covered in this chapter include:

overview of CommandShell

setting up CommandShel |

using CommandShell windows

customizing CommandShell windows

using Mac OS editing tools in a CommandShell window
exiting CommandShell




Overview of CommandShell

CommandShell is an application provided by Apple Computer to let you
communicate with a Network Server running AlX from aremote Mac OS
dient. From the Mac OS dient, you can send commands to the AIX system to
perform such tasks as system administration and troubleshooting.

The CommandShell application consists of a Mac OS dient component and
an AIX server component. These components exchange information through
Apple events and let you run commands on the Al X server from aremote
Mac OS system.

From CommandShell, you can run any standard AIX administration
command, suchassnit orinfo -a.

Setting up CommandShell
To use CommandShell with AlX, you must complete the following steps.

1 Install and activate AppleTalk on the server.

For information about setting up AppleTalk, see Chapter 7, “Setting Up
AppleTalk and AppleTalk Services”

2 Start the PPC daemon on the server.
3 Runthe AppleTalk Services program on the remote Mac OS client, and ensure that you

install CommandShell, CommandShell VT102, and Network Server Passwd Tool .

Use the Mac OS Utilities for the Network Server With Al X disk provided with
AlX to install CommandShell. For complete installation instructions, see
“Installing Mac OS Utilities on a Mac OS Client” in Chapter 2, “Installing
AlIX on Your Network Server”

4 Ensure that you have an account on the server.

Once you have satisfied these requirements, you are ready to use the
CommandShell application.
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Starting CommandShell
To start a CommandShell session:

1 On the remote Mac OS client, double-click the CommandShell icon.

CommandShell

The menu bar changes to display the CommandShell menu and the “Select a
CommandShell Server” dialog box appears.

Select a CommandShell server.
Macintoshes Services

Server 1 CommandsShell |43

Server 2

Server 3

AppleTalk Zones

Sales

Marketing

Engineering

Suppart 5y
[cancel || ok

2 Select connection options.

In the AppleTalk Zones box, click the zone of the server you want. If you do
not have zones configured for your network, the dialog box does not have an
AppleTalk Zones box and you do not need to specify a zone

In the Macintoshes box, dick the name of the server that you want to connect
to.

In the Services box, select the CommandShell application.
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3 Click OK.
A user authorization dialog box appears

P

Link to “CommandShell” on “Network Server”
as:

) Guest
@ Registered User

Name: | root |

Password: I:I

4 Type your user name and password.

5 Click OK.
A window for CommandShell appears.

EI=———————= Nelwork Server E==—"—————1=
(7]

* *

* *

# Helcome to AIX Uersion 4. 11 #*

* *

* *

* Please ses the README file in fusr/lpp/bos for information pertinent to *

# this release of the ALY Operating System. #*

* *

* *

Last login: Fri Dec 1 @3:46:28 C5T 1995 on Sfdev/pts/@ from symbiont

=1
]
]
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Using CommandShell windows

The following sections describe how to use the windows in CommandShell.

Displaying CommandShell windows

When you create a CommandShell connection, a window appears. You can
display additional windows by

» choosing New Connection from the File menu

» pressng Command-N

The windows are numbered in the order in which they are created.

Arranging CommandShell windows

There are three ways to arrange CommandShell windows on the screen. Use
the Window menu to choose window options.

» Standard position. When you create a new window, it appears in front of
and dightly below the previoudy created window.

= Tiled. You can tile the windows to arrange them alongside each other with
their edges touching. Tiling windows reduces the size of the windows so
they fit on the screen. You can tile windows horizontally and vertically.

» Resizing and dragging. You can arrange CommandShell windows by using
their resize boxes and by dicking on their title bars to drag the windows to
new locations on the desktop.
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Recording the contents of a window

As new lines are added to a CommandShell window, the top lines may scroll
past the top edge of the window. CommandShell automatically records a
preset number of these lines. This allows you to view them by scrolling
upward. By default, CommandShell records 300 lines

CommandShell does not save any lines after you close a window. If you are
working with text that you don't want to lose, save the information to afile

You can stop CommandShell from recording the top line of the active
window by choosing the Don't Record Lines Off Top command from the
Commands menu.

If you want to erase lines that have been recorded, choose the Clear Lines Off
Top command from the Commands menu. This command operates on the
active window only.

Saving a CommandShell connection

You can save all of your current connections with the Save Connections
command from the File menu. This command saves all of your current
connectionsin afile You can open this document to restore your connections.

Closing a CommandShell window

There are three ways to cose a window:
= Choose Close from the File menu.

= Press Command-W.

= Click the dlose box of the window.

Note: Before you can close awindow, it must be the active window.

If you close awindow in which a process or program is running, the process
stops. An aert box warns you of this and gives you the option of keeping the
window open.
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Customizing CommandShell windows

If you use CommandShell windows often, you may find it convenient to
establish an ideal arrangement of windows so they are always set up the way

that you want.

Presetting window defaults

The Active Window Settings command in the Preferences menu lets you

= Specify window position

= Save aninitial command to execute on login

= change thetitle of the window
= change the number of lines to record
= Select terminal settings

Presetting the appearance of new windows

You can change the default settings that control the appearance of new

windows before you create them.

Choose New Window Settings from the Preferences menu.

The New Window Settings dialog box appears.

New Window Settings

Window Title Prefix: |Commandshell

[ Use Active Window Settings ]

Window Cascade Origin: Window Size:

Top: Rows:

Left: Columns:
Font: Size: (9]
Maximum number of lines recorded off top:
 Terminal Settings... |
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You can decide to extend the active window settings to all new windows by
selecting Use Active Window Settings

This dialog box also allows you to preset the window size, the screen font,
and the maximum number of lines to save

Using Mac OS editing tools in CommandShell windows

You can use standard Mac OS editing tools such as copy and paste while
working in CommandShell windows These commands allow you to paste a
series of commands or along, complex command into another window
without having to retype it. When you press Return, AIX runs the pasted
command.

Exiting CommandShell
To exit CommandShell:

s Choose Quit from the File menu.
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Troubleshooting

This chapter describes how to solve problems that you may encounter when
using AIX. This chapter is not a complete troubleshooting reference This
chapter provides information to help you when you cannot get to InfoExplorer
to examine the complete list of error messages, LCD display codes, and
problem-solving suggestions.

The topics covered in this chapter include

s Starting your Network Server from maintenance mode and displaying a
prompt to examine your root volume group

= correcting an unresponsive system
= responding to error messages during installation, both three-digit error
codes on the LCD display and text messages on your screen

For information about solving problems related to your hardware, refer to
Setting Up Your Network Server.

The Al X \ersion 41 Messages Guide and Reference includes reference and
recovery information for seven-digit error messages and three-digit error
codesin the LCD display. You can access this guide through InfoExplorer.




Booting from maintenance mode

If you cannot start your Network Server from your hard disk, you can access
gystem information from mai ntenance mode
To use mai ntenance mode to examine and restore i nformation:

1 Insert the Installation CD or a bootable backup tape.

2 Shut down the Network Server.
Enter the command shut down - F.

3 Turn the front key switch to the left (service) position.

4 Turn on your Network Server.
The computer starts from the CD or backup tape
A message appears asking you to define the system console

5 Press Fl1and then the Enter key to use the local display as your console.

You need an extended keyboard to identify your console unless you are
installing with aterminal connected to the modem port.

6 When prompted, select alanguage for installation instructions.

For English, type 1 and press Enter.

The following message appears on your screen.

Wel cone to the Base Operating System
Instal |l ati on and Mai nt enance

Type the nunber of your choice and press Enter.
Choice is indicated by >>>.

1 Start install now with default settings

2 Change/ show installation settings and install
>>> 3 Start mai ntenance node for systemrecovery

88 HELP ?

99 PREVI QUS MENU
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7

10

11

Type 3 and press Enter.
A menu appears that lists options for system mai ntenance

Mai nt enance

Type the nunber of your choice and press Enter.
Choice is indicated by >>>.

>>> 1 Access a Root Vol une G oup
2 Copy a System Dunp to Renpvabl e Medi a
3 Access Advanced Mai ntenance Functions
4 Install froma System Backup
88 HELP ?

99 PREVI QUS MENU

Type 1 and press Enter.

The choice indicated by 1 lets you access aroot volume group.

When you choose 1, the system warns you that you might overwrite existing
information and then lists the available volume groups.

Type the number of the volume group that you want to examine and press Enter.

A menu appears that lists the file systems on this volume group.

Type the number of the file system that you want to mount and examine and press Enter.

Your system lists options for mounting the file system.

Choose Mount File System and Start Shell.

Your system mounts the file system and provides a shell for you to enter
UNIX commands You can use UNIX commands in this shell to examine the
file system for problems and restore corrupted i nformation.
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Correcting an unresponsive system

A hardware or software problem can make your Network Server
unresponsive The suggestions in this section might help you correct the
problem and restart your Network Server. If your Network Server is still
unresponsive, refer to Setting Up the Network Server.
For an unresponsive system, first check your hardware
» Verify that the power light is on.

If not, see the hardware guide.

» Check for athree-digit code on the LCD panel on the front of your
Network Server.

If the display is not blank, look up the three-digit code in the next section,
“System Error Messages”

= Ensure your cable connections are securely attached.

= Ensure that your terminal is on and the brightness is properly adjusted.

If your Network Server is still unresponsive, check for software problems. Often,
a stopped or stalled process may make your Network Server unresponsive

= Use Control-D or Control-C to cancel a stalled process

» Restart your Network Server.

Before you restart, ensure the front key is turned to the upright (unlocked)
position and the boot device is on. To restart, press the reset button.

on/off

el ——

| Reset button

System error messages

Most error messages you see can be looked up in InfoExplorer. This section
lists messages and recommended actions for situations when you cannot
access | nfoExplorer, such as during installation.
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Three-digit display error codes during system startup

For most problems with the booting process, a three-digit error code appears
on the LCD panel on the front of your Network Server. This section lists the
possible error codes and recommended action. For the procedures in this
section, you must have root privileges

This section describes the display values for system startup.

The error codes in the following table require you to run a hardware
diagnostic program to isolate and correct the problem. This table tells you
what device is causing the problem and at what point in the boot cycle

Display value System action

510 The system has started the Configuration manager.

511 The Configuration manager has completed.

517 The system is attempting to mount the / (root) and / usr file systems. These
file systems are of type boot f s. If the mount does not successfully complete
during a network boot, the system changes the three-digit display value to 518.

585 The system is configuring the network.

501 The system is configuring the Logical Volume Manager (LVM).

594 The system is configuring an asynchronous 1/O.

704 The system is configuring the 2.2 GB 16-bit SCSI disk drive.

723 The system is configuring an unknown CD-ROM or SCSI device driver.

727 The system is configuring an asynchronous device.

731 The system is configuring an unknown PTY.

811 The system is configuring the processor complex or the standard input/output.

812 The system is configuring the memory.

814 The system is configuring the NVRAM.

821 The system is configuring the standard keyboard adapter.

823 The system is configuring the standard mouse adapter.

828 The system is configuring the standard floppy disk adapter.

831 The system is configuring the serial port 2.

868 The system is configuring the integrated SCSI adapter.

871 The system is configuring the graphics subsystem adapter.

921 The system is configuring a keyboard.

925 The system is configuring a three-button mouse.

935 The system is configuring a 3.5-inch diskette drive.

9002 The system is configuring the 825 SCSI card.
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Error Code 522

The display value 522 indicates that the / et ¢/ i ni t t ab file has been
incorrectly modified or is damaged and the configuration manager was started
fromthe/ et c/i ni tt ab file with conflicting options. This causes the system
to stop.

You can solve this problem by entering mai ntenance mode and either
correcting the damaged file or replacing it with a copy from the installation
media or another system.

Error Code 551

If the boot process halts with a display value of 551, there may be a problem
with any of the following.

Problem Solution

/ dev is missing or corrupted  nkdir /dev
bad boot logical volume bosboot -a
/ et c problems restore selective files (if possible) or reinstall

If these solutions do not correct the problem, try the following command
from maintenance mode:

fsck hdiskn
where n is the number of the hard disk that contains the root volume group.

Thef sck command checks file system consistency and repairs the file
gystem.

Error Code 552

The 552 error code indicates that the Network Server isin an infinite loop. To
fix the problem, clean up the file system (using the f sck command) and
examine the log volume.

To examine the log volume, run the following command at the maintenance
mode prompt for the root volume:

/etclaix/1ogform/dev/hd8
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This command reformats your log logical volume After you run this
command, restart your Network Server.

Error Code 553

If the Network Server stops at display value 553 during the boot process, it
may be due to a problem running or reading the/ et ¢/ i ni tt ab file The
/etcl/inittab file controls the initialization process. This problem occurs
when/ t mp or root (/) file systems are full.

To solve this problem:

Boot from maintenance mode and access the root volume group.

Check for available space on the file system.

Use the df command to check for space. For example, enter
df -1 /dev/hdiskO

Erase files as necessary to get disk space.

Oftenthe/snmit.logand/snit.script filescause the problem. Remove
them with the following command:

rm/smt.log /smit.script
Examinethe/ et c/ i ni t t ab file for corruption.

The file may be empty or missing or it may have an incorrect entry. You may
have to recreate this file or fix an entry.

If the / et ¢/ i ni ttab fileis not corrupt, look for modification or permissions
problems with the following files: / et ¢/ envi r onnent ,/ bi n/ sh,/ bi n/ bsh,
letcl/fsck,/etc/profile,/.profile.

Return the front key to the upright (unlocked) position and restart your Network Server.

Error Code c31 or ¢32

If the Network Server stops at value c3L or ¢32, it istrying to locate the
system console The Network Server may not locate the console if the console
is defined but not enabled or if the consoleisa TTY that cannot be reached.
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First, look for loose cables If the cable connections are correct, boot into
mai ntenance mode and enter a shell for the root volume group. Enter the
following command to enable the console;

chcons -a | ogi n=enabl e /dev/hft/0

Restart your Network Server.

System messages during installation

This section lists the messages that can appear during the installation of AlX.
In this section, the messages that appear on your screen are in the Courier
font; recommended actions follow the messages.

0516-404 all ocp: Not enough resources available to fulfill
al l ocation. Either not enough free partitions or not
enough physical volunes to keep strictness. Try again with
different allocation characteristics.

0516- 788 extendl v: Unable to extend | ogical vol umne.

0503-008 installp: There is not enough free disk space in
file system/usr. An attenpt to extend this file system
was unsuccessful. Make nore space avail able, then retry
this operation.

These messages indicate that there is not enough space to compl ete the
installation. To solve the problem, do one or more of the following:
= Select fewer file sets than the number originally selected for installation.
= Extend the root volume group to another disk. Enter

extendvg rootvg hdi skn

where n is the number of the specified disk.
= Remove user-defined file systems to free space in ther oot vg file system.

BOS install: After saving all the data fromthe previous
systemin /tnp, it was discovered that there will not be
enough free space in /tnp to make the boot image. Pl ease
reboot in nornmal node and increase the size of /tnmp or
reduce the number of files to save as listed in the
/etc/preserve.list file.
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During a preservation install, fileslisted in/ et ¢/ preserve. 1 i st were
copied into/ t np. After doing this, there was not enough roomin/ t np to
create the boot image Reboot your Network Server in normal mode and
increase the size of / t np or reduce the number of files to be saved.

BOS install: Could not create boot inage.

Thebosboot command failed. Check the/ var/ adnf r as/ devi nst . | og
file for errors

The followi ng disks failed the prelinminary diagnostic
tests: <disk name>.

Theinstallation disk failed the diagnostic pretest. Run full diagnostics on
the specified disk.

i mge.data file contains no vg_data stanza for rootvg.
The installation cannot conti nue.

i mage. data has invalid | ogical volume data. Cannot
conti nue.

i mage data has invalid file systemdata. Cannot
conti nue.

Use the default i mage. dat a file on the Installation CD.

0516- 366 putlvodm Vol ume group rootvg is |ocked. Try
agai n.

0516- 788: extendlv: Unable to extend | ogical vol une.

0503-008 installp: There is not enough free di sk space
inthe file system/usr. An attenpt to extend this file
system was unsuccessful. Make nore space avail abl e, then
retry this operation.

One of these messages might occur if you have interrupted the installation
of your optional software When you interrupt an installation, the Network
Server sometimes locks the root volume group. To unlock the root

volume group:
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1 Loginasroot.
2 Enterchvg -u rootvg.

3 Entersmit _install and attempt to install your optional software again.

installp: An error occurred during bosboot processing.
Pl ease correct the problem and rerun.

0301- 152 bosboot: not enough file space to create:
[t p/ uni x.

Thebosboot command is unable to finish because of insufficient spacein
/t mp. Extend the/ t np file system (usesmi t chfs), or free some space and
restart your Network Server.

installp: An error occurred during bosboot processing.
Pl ease correct the problem and rerun.

301- 155 bosboot: Invalid or no boot device specified.

Aninvalid device is specified. The bosboot command could not complete
because it could not locate the required boot device To solve the problem,
determineif the link to the boot device is missing or incorrect. Correct the
error and complete installation.

1 Toidentify the book disk, enter
I slv -m hd5
The Network Server displays the name of the boot disk.

2 Create alink between the boot device indicated and the / dev/ i pl devi ce file by
entering
I n /dev/ boot _devi ce_nane /dev/ipl device

An example of the boot _devi ce_nane ishdi skO.
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3 Rerun or continue the installation.
No di sks are avail abl e.

No hard disks are configured on the Network Server. You can only use the
mai ntenance option of the installation program. You can view the devicesfile
from the maintenance shell by entering the following command:

cat /etc/objrepos/devs

Turn off your Network Server and examine devices to ensure that all SCS
devices are unique and that SCSI devices are properly terminated. Also,
check the physical connections between devices. Then, restart and try the
installation again.

If these steps do not work, run diagnostics on your hard disk.
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